M16 Laser
16-Segment Solid-State LiDAR Module
USER GUIDE
This page intentionally left blank
**DISCLAIMER**

Description of Products, including but not limited to specifications and drawings, and other related information contained in this document are provided only to illustrate their operation and application examples.

LeddarTech reserves the right to modify its Products at any time, without notice, at its sole discretion. Performance specifications and operating parameters of the Products are determined in an independent state and are not guaranteed to perform the same way if installed in a customer product.

LeddarTech has made every effort to ensure that the information contained in this document is accurate, but LeddarTech accepts no liability for any errors or omissions contained herein.

Please contact a LeddarTech sales representative if you have any questions regarding the information contained in this document or regarding LeddarTech Products. For the most recent version of this document, please go to the LeddarTech website. We also highly recommend that you read carefully our Standard Sales Terms and Conditions, our Product Warranty and our End-User License Agreement. You will find this documentation at www.leddartech.com in section Resources-Where to buy.

**WARRANTY**

Visit our website at leddartech.com to read the product warranty conditions.

Keep this user guide for future reference.
# Table of Contents

List of Figures ......................................................................................................................... 7
List of Tables ............................................................................................................................ 9

1. Introduction .......................................................................................................................... 11
   1.1. Description ....................................................................................................................... 11
   1.2. Underlying Principles ..................................................................................................... 18

2. Getting Started ..................................................................................................................... 19
   2.1. Setup ............................................................................................................................... 19
   2.2. Connecting to the Module ............................................................................................. 23

3. Measurements and Settings ................................................................................................. 26
   3.1. Distance Measurement ................................................................................................. 26
   3.2. Data Description .............................................................................................................. 26
   3.3. Acquisition Settings ....................................................................................................... 29
       3.3.1. General Settings ...................................................................................................... 29
       3.3.2. Enabling and Disabling Segments ............................................................................ 35
       3.3.3. Static threshold ....................................................................................................... 36
   3.4. Measurement Rate .......................................................................................................... 37
   3.5. CPU Load ......................................................................................................................... 40
   3.6. Serial Port Settings .......................................................................................................... 40
   3.7. CAN Port Settings .......................................................................................................... 42

4. Communication ..................................................................................................................... 44
   4.1. Serial Port ......................................................................................................................... 44
   4.2. CAN Bus ............................................................................................................................ 50

5. Leddar™ Configurator ............................................................................................................ 61
   5.1. Introduction ...................................................................................................................... 61
   5.2. Connection Window ......................................................................................................... 61
   5.3. Leddar™ Configurator Main Window ............................................................................ 62
       5.3.1. Toolbar Display Controls ......................................................................................... 63
       5.3.2. Fit to Window ........................................................................................................... 63
       5.3.3. Force Equal Horizontal and Vertical Scales ............................................................. 64
       5.3.4. Zoom In .................................................................................................................... 64
       5.3.5. Zoom Out .................................................................................................................. 64
       5.3.6. Scale ......................................................................................................................... 64
       5.3.7. Panning and Zooming .............................................................................................. 64
       5.3.8. Changing the Module Origin .................................................................................... 66
       5.3.9. Changing the Module Orientation.............................................................................. 67
   5.4. Settings ............................................................................................................................ 68
       5.4.1. Device Name .............................................................................................................. 68
       5.4.2. Acquisition Settings ................................................................................................. 70
       5.4.3. Module Position ........................................................................................................ 71
       5.4.4. Advanced Detection Zones ....................................................................................... 71
       5.4.5. General ....................................................................................................................... 72
       5.4.6. Serial Ports ................................................................................................................ 74
5.4.7. CAN Ports .................................................................................................................... 75
5.5. Saving and Loading a Configuration .............................................................................. 77
5.6. Configuring Detection Records ..................................................................................... 77
5.7. Using Detection Records ............................................................................................... 80
5.8. Data Logging ................................................................................................................... 82
5.9. Device State .................................................................................................................... 84
5.10. Preferences .................................................................................................................. 85
5.11. Raw Detections ............................................................................................................ 86
5.12. View Serial Part Data ................................................................................................. 90

6. Specifications .................................................................................................................... 92
   6.1. General ........................................................................................................................ 92
   6.2. Environmental .............................................................................................................. 93
   6.3. Regulatory Compliance ............................................................................................... 93
   6.4. Optical ........................................................................................................................ 94
   6.5. Performance ............................................................................................................... 96
   6.6. Dimensions ................................................................................................................ 97
       6.6.1. 36° x 0.2° Module (M16R-75J0002) ........................................................................ 97
       6.6.2. 19° x 0.3° Module (M16R-75J0012) ..................................................................... 98
       6.6.3. 19° x 3° Module (M16R-75J0003) ........................................................................ 99
       6.6.4. 48° x 0.3° Module (M16R-75J0007) ..................................................................... 100
       6.6.5. 48° x 3° Module (M16R-75J0008) ..................................................................... 101
       6.6.6. 48° x 5.1° Module (M16R-75J0001) ..................................................................... 102
       6.6.7. 48° x 5.5° Module (M16R-75J0011-1) ................................................................. 103
       6.6.8. 99° x 0.3° Module (M16R-75J0009) ................................................................. 104
       6.6.9. 99° x 3° Module (M16R-75J0010) ..................................................................... 105

7. Technical Support ............................................................................................................ 106

Appendix A. Example of a 0x41 Modbus Function ............................................................ 107
Appendix B. Example of a 0x04 Modbus ......................................................................... 110
Appendix C. Example of a CAN Bus Detection Request .................................................. 112

Index ..................................................................................................................................... 114
List of Figures

Figure 1: Front view of the M16 LSR ................................................................. 12
Figure 2: Top view and terminal block connector of the M16 LSR .................. 13
Figure 3: Back view of the M16 LSR ............................................................... 13
Figure 4: M16 LSR working diagram ......................................................... 15
Figure 5: Illumination area and detection zone ............................................ 18
Figure 6: Welcome to the Leddar™ Software 3 Setup Wizard dialog box .... 20
Figure 7: End-User License Agreement dialog box ...................................... 20
Figure 8: Product Types dialog box .............................................................. 21
Figure 9: Destination Folder dialog box ....................................................... 22
Figure 10: Installing ..................................................................................... 22
Figure 11: Finishing the installation .............................................................. 23
Figure 12: Connecting to a module ............................................................... 24
Figure 13: Connection dialog box ................................................................. 24
Figure 14: Main window ............................................................................. 25
Figure 15: Distance measurement ............................................................... 26
Figure 16: Raw Detections dialog box .......................................................... 27
Figure 17: General tab – Acquisition Settings dialog box ......................... 29
Figure 18: Detection thresholds ................................................................. 32
Figure 19: Measurement smoothing example ............................................ 34
Figure 20: Segments tab – Acquisition Settings dialog box ...................... 35
Figure 21: Disabled segments example ....................................................... 36
Figure 22: Static Threshold tab – Acquisition Settings dialog box ............. 37
Figure 23: Device State window ................................................................ 40
Figure 24: Raw Detections dialog box docked on the side of the main window 61
Figure 25: Connection dialog box ............................................................... 62
Figure 26: Leddar™ Configurator main window .......................................... 63
Figure 27: Zooming in (left) and out (right) horizontally ......................... 65
Figure 28: Zooming in (left) and out (right) vertically ............................... 65
Figure 29: Detection point coordinates ....................................................... 66
Figure 30: Dot indicator to modify the module origin ................................ 66
Figure 31: Module position display ............................................................ 67
Figure 32: Red bar to rotate the module position ........................................ 68
Figure 33: Device menu and The Configuration menu items ................... 69
Figure 34: Device Name dialog box ........................................................... 69
Figure 35: Acquisition Settings dialog boxes ............................................. 70
Figure 36: Device menu and Module Position dialog box ......................... 71
Figure 37: Device menu, and the Configuration and Advanced Detection Zones menu items 71
Figure 38: Advanced Detection Zones dialog box .................................... 72
Figure 39: Device menu, and the Configuration and Communication menu items 72
Figure 40: General Settings dialog box ...................................................... 73
Figure 41: LeddarHost dialog box ............................................................. 73
Figure 42: Device menu, and the Configuration and Communication menu items 74
Figure 43: Serial Ports Settings dialog box ............................................... 74
Figure 44: Device menu, and the Configuration and Communication menu items 75
Figure 45: CAN Port Settings dialog box ................................................... 76
Figure 46: File menu ................................................................. 77
Figure 47: Settings menu ............................................................ 77
Figure 48: Preferences dialog box ............................................... 78
Figure 49: File menu ................................................................. 79
Figure 50: File menu to stop a recording ...................................... 79
Figure 51: File menu to open a recording .................................... 81
Figure 52: Record Replay dialog box .......................................... 81
Figure 53: Settings menu ............................................................ 82
Figure 54: Preferences dialog box for logging data ............................ 83
Figure 55: File menu ................................................................. 83
Figure 56: File menu to stop data recording .................................. 83
Figure 57: View menu ............................................................... 84
Figure 58: Device State window .................................................. 84
Figure 59: Settings Menu and Preferences Dialog Box ...................... 85
Figure 60: View menu and Raw Detections dialog box ...................... 87
Figure 61: Example of detection filtering in the Raw Detection dialog box ................................................................. 87
Figure 62: View menu ............................................................... 90
Figure 63: Serial Port Viewer dialog box ....................................... 91
Figure 64: Serial port measurement .............................................. 91
Figure 65: Horizontal field of view (HFOV) and Vertical field of view (VFOV) ................................................................. 95
Figure 66: Module 36° x 0.2° dimensions ....................................... 97
Figure 67: Module 19° x 0.3° dimensions ....................................... 98
Figure 68: Module 19° x 3° dimensions ........................................ 99
Figure 69: Module 48° x 0.3° dimensions ...................................... 100
Figure 70: Module 48° x 3° dimensions ....................................... 101
Figure 71: Module 48° x 5.1° dimensions ...................................... 102
Figure 72: Module 48° x 5.5° dimensions ...................................... 103
Figure 73: Module 99° x 0.3° dimensions ....................................... 104
Figure 74: Module 99° x 3° dimensions ....................................... 105
List of Tables

Table 1: Terminal block connector pin definition ................................................................. 14
Table 2: RS-485 pin definition ............................................................................................... 16
Table 3: Expansion connector pin definition ......................................................................... 16
Table 4: UART pin definition (TTL 3.3V) ............................................................................ 17
Table 5: CAN pin definition ................................................................................................. 17
Table 6: SPI pin definition ................................................................................................... 17
Table 7: Distances per segment (channel) ............................................................................. 18
Table 8: Raw Detection field description ............................................................................. 27
Table 9: Flag value description ............................................................................................ 28
Table 10: Status value description ....................................................................................... 28
Table 11: Acquisition setting description ............................................................................ 30
Table 12: Base rate ............................................................................................................... 37
Table 13: Measurement rate ................................................................................................. 38
Table 14: Serial port settings description ............................................................................ 41
Table 15: Maximum detections per  Baud rate/Measurement rate settings ......................... 42
Table 16: CAN port settings ................................................................................................. 42
Table 17: Report server ID message ..................................................................................... 44
Table 18: Get detection message (detection fields) ............................................................... 45
Table 19: Get detection message (trailing fields) ................................................................. 45
Table 20: Get detection message (detection fields) ............................................................... 46
Table 21: Get detection message (trailing fields) ................................................................. 46
Table 22: Read input register message .................................................................................. 47
Table 23: Read holding register message definition ............................................................ 49
Table 24: CAN bus request message .................................................................................... 51
Table 25: CAN bus request message (GET input data) ......................................................... 52
Table 26: CAN bus request message (GET holding data) ..................................................... 52
Table 27: CAN bus request message (SET holding data) ...................................................... 53
Table 28: CAN bus answer message .................................................................................... 55
Table 29: CAN bus number of detection message ............................................................... 56
Table 30: CAN bus answer message (GET input data) ........................................................ 57
Table 31: Standard CAN bus detection message ................................................................. 58
Table 32: Flag information of measurement ....................................................................... 58
Table 33: CAN bus detection message definition with flag information ........................... 60
Table 34: Serial port settings description ............................................................................ 75
Table 35: CAN port settings description .............................................................................. 76
Table 36: Field description of the log text file ...................................................................... 82
Table 37: Status value description ........................................................................................ 89
Table 38: Status value description ........................................................................................ 90
Table 39: General specifications .......................................................................................... 92
Table 40: Environmental specifications ............................................................................... 93
Table 41: Optical specifications ............................................................................................. 94
Table 42: Module performances ......................................................................................... 96
1. Introduction

The Leddar™ M16 module or M16 LSR (laser) enables developers and integrators to make the most of Leddar™ technology through integration in detection and ranging systems. The purpose of the M16 LSR module is to easily and rapidly be integrated in various applications.

The M16 LSR can be configured to be used in very simple applications or to perform more complex tasks depending on the hardware and software settings.

1.1. Description

The M16 LSR contains the following:
- Receiver assembly
- Source and control assembly

The M16 LSR offers the following features:
- Horizontal field of view (FOV): 19°, 36°, 48°, and 99°
- 16 detection segments
- Real-time data acquisition and display (through USB)
- RS-485 port for measurement acquisition
- CAN bus for measurement acquisition

Interfaces available for custom application development:
- RS-485
- CAN bus
- DIP switches¹ (4)
- MicroSD card slot¹
- Expansion connector (UART, CAN, SPI¹, GPIO¹, DAC¹)

¹ Not implemented in the current MCU firmware.
The terminal block is an 8-pin connector at the top of the module. It provides CAN, RS-485, and power connectivity.
Figure 2: Top view and terminal block connector of the M16 LSR

Figure 3: Back view of the M16 LSR
Table 1: Terminal block connector pin definition

<table>
<thead>
<tr>
<th>Pin</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>GND</td>
<td>DCIN</td>
<td>GND</td>
<td>RS-485+</td>
<td>RS-485-</td>
<td>GND</td>
<td>CAN-H</td>
<td>CAN-L</td>
</tr>
</tbody>
</table>

Pin 2 allows the user to power the device directly through the terminal block instead of the DC connector. Ground is connected via pins 1, 3, and 6.

MicroSD card slot

The source and control assembly is equipped with a MicroSD card reader/writer. The slot is provided for custom application development and is not implemented in the current MCU firmware. Please contact LeddarTech® for future enhancements of the firmware.

Reset button

The reset button, located on the left side of the module, restarts the module. This can be used as an alternative to cycling the power.

MCU JTAG

The JTAG port can be used by application developers to load and debug MCU firmware.

USB port

The USB port is a standard 2.0, 12-MBit/s port. This communication link is used by the Leddar™ Configurator software and provides a link for prototyping new applications (contact LeddarTech for the SDK).

Power connector

The power connector provides the module with a power source from 10 V to 30 V.

Receiver assembly

The receiver assembly contains the photodetector array (16 elements) and the controller for laser pulsing and data acquisition. Data acquisition is performed at a sampling frequency of 62.5 MHz.

The module assembly generates a full waveform per segment at the module measurement rate.

**NOTE:** The module measurement rate varies according to the oversampling, accumulation settings, and the pulse rate according to FOV configuration.

**NOTE:** Lens coating color for 48° configuration may change from one sample to another from greenish to bluish, but the inherent properties of the lens are not affected in the field of application of this product.
Source and control assembly

The laser pulsing is controlled by the receiver assembly since the receiver data acquisition must be synchronized with the laser pulses. A temperature module located near the laser is used to implement temperature compensation on the ranging results.

The MCU recovers the waveforms generated by the receiver assembly, performs full waveform analysis, and generates detection and ranging data. The data can be displayed in software after a connection has been established through the USB link.

The control assembly offers several external interfaces, but most are provided for custom application development and are not implemented in the current MCU firmware. Please contact LeddarTech for future enhancements of the firmware.

The following diagram illustrates how the components of the module interact with one another.

![Diagram of module components](image_url)

Figure 4: M16 LSR working diagram
The receiver assembly includes the reception optics and the photodetector circuit.

The control assembly includes the terminal block, the MCU, and the external interfaces.

The source assembly includes the laser, the laser drivers, and emission optics.

**DIP switches**

The source and control assembly is equipped with four DIP switches. They are unused by the current design and are thus available as additional options for development of custom applications.

**RS-485 port**

The RS-485 (ANSI/TIA/IEA-485) is a two-wire, half-duplex differential serial communication port. It is often used in electrically noisy environments. The following table provides the pin definitions compliant to RS-485 standards.

<table>
<thead>
<tr>
<th>Table 2: RS-485 pin definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin</td>
</tr>
<tr>
<td>Pin 4</td>
</tr>
</tbody>
</table>

**CAN bus**

The CAN bus is implemented via a differential pair. Pin 7 connects to the CAN-High (CAN+) and pin 8 to CAN-Low (CAN-). The ISO 11898 standard describes the CAN technology.

**Expansion connector**

The expansion connector is another connectivity option that can be used for custom application development.

**NOTE:** The UART link is the only option implemented in the current MCU firmware.

Even numbered pins connect to the ground and odd-numbered pins are described below.

<table>
<thead>
<tr>
<th>Table 3: Expansion connector pin definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>
• UART
  Pins 1, 3, 5, and 7 connect to UART2 from the MCU.

  Table 4: UART pin definition (TTL 3.3V)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TX</td>
</tr>
<tr>
<td>3</td>
<td>RX</td>
</tr>
<tr>
<td>5</td>
<td>CTS</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
</tr>
</tbody>
</table>

• CAN
  Another CAN bus connector is available. Contrarily to the one on the terminal block, the user is responsible for converting the receiver/transmitter signals to the CAN standard (CAN-High and CAN-Low).

  Table 5: CAN pin definition

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>TX</td>
</tr>
<tr>
<td>11</td>
<td>RX</td>
</tr>
</tbody>
</table>

• GPIO
  General-purpose inputs/outputs are available through pins 13, 15, 17, 19, 21, 23, 25, and 27.

• SPI
  The generic serial port interface functionality is available through pins 19, 21, 23, and 25.

  Table 6: SPI pin definition

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>MOSI</td>
</tr>
<tr>
<td>21</td>
<td>MISO</td>
</tr>
<tr>
<td>23</td>
<td>SCLK</td>
</tr>
<tr>
<td>25</td>
<td>CS</td>
</tr>
</tbody>
</table>

• DAC
  Pin 29 is a digital-to-analog output. The reference voltage is 3.3 V.

Status LEDs

There are two LEDs on this unit. One shows the activity of the microcontroller (D6 blinking LED) and the other shows the USB connection status (D5 LED).
1.2. Underlying Principles

Created by LeddarTech®, Leddar™ (light-emitting diode detection and ranging) is a unique sensing technology based on laser illumination (infrared spectrum) and the time-of-flight of light principle. The laser emitters illuminate the area of interest (pulsed typically at 100 kHz) and the multichannel module receiver collects the backscatter of the emitted light and measures the time taken for the emitted light to return back to the module. A 16-segment photodetector array is used and provides multiple detection and ranging segments. Full-waveform analysis enables detection and distance measurement of multiple objects in each segment, provided that foreground objects do not fully obscure objects behind them.

Figure 5 illustrates the illumination area and detection segments. The 16 segments provide a profile of the object in the beam. In other installations, the 16 segments can be used to locate and track one or multiple objects in the beam.

<table>
<thead>
<tr>
<th>Segment</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance (m)</td>
<td>9.71</td>
<td>8.52</td>
<td>7.55</td>
<td>6.79</td>
<td>5.68</td>
<td>5.26</td>
<td>4.91</td>
<td>4.61</td>
<td>4.82</td>
<td>5.18</td>
<td>5.62</td>
<td>6.18</td>
<td>6.88</td>
<td>7.80</td>
<td>8.97</td>
<td></td>
</tr>
</tbody>
</table>

Figure 5: Illumination area and detection zone

The core of Leddar™ sensing is the pulsing of diffused light, collection of reflected light, and full-waveform analysis (including oversampling and accumulation). The light source type, the number of light sources, and the illumination and reception beam can all be tailored to fit specific application requirements such as detection range, beam, and spatial resolution.
2. Getting Started

This chapter presents the steps to install Leddar™ Configurator and start using the M16 LSR.

2.1. Setup

This section presents the Leddar™ Configurator installation and the procedure to set up the M16 LSR. All software operations are described in chapter 5.

To install Leddar™ Configurator:

Download the LeddarInstaller.exe file from our Web site at https://leddartech.com/resources/#product-download/.

In the Product Download section, select LeddarConfigurator Software and then click LeddarInstaller.exe. Double-click the file to start the installation.

**NOTE:** For Microsoft Windows® XP, an upgrade of Microsoft components and a restart may be required. Installation will automatically resume after restarting the computer.

1. On the computer desktop, double-click the Leddar™ Configurator icon.
2. In the Welcome to the Leddar™ Software 3 Setup Wizard dialog box, click Next.
3. In the End-User License Agreement dialog box, read the terms of the agreement, select the I accept the terms in the License Agreement check box, and click Next.
4. In the **Product Types** dialog box, the Leddar™ Software the **Development Kit** check box is selected by default.

**NOTE:** If you do not want to install the development kit, clear the check box.

![Figure 8: Product Types dialog box](image)

5. Click Next.

6. In the **Destination Folder** dialog box, click **Next** to select the default destination folder.
   
   OR
   
   Click the **Change** button to choose a destination folder.
7. In the **Ready to Install Leddar™ Software 3** dialog box, click the **Install** button.
8. In the **Completed the Leddar™ Software 3 Setup Wizard** dialog box, click **Finish**.

![Completed the Leddar™ Software 3 Setup Wizard](image)

**Figure 11: Finishing the installation**

Leddar™ Configurator creates an icon on the computer desktop.

### 2.2. Connecting to the Module

The first time the module is connected to a computer, a few seconds are required for Windows™ to detect it and complete the installation.

Once the installation is completed, you can connect to the module.

**To connect to the module:**

1. Connect the power cord to the module and to a power outlet.
2. Connect the USB cable to the module and to the computer.
3. On the computer desktop, double-click the **Leddar™ Configurator** icon.
4. In Leddar™ Configurator, click the connect button.

![Figure 12: Connecting to a module](image1)

5. In the Connection dialog box, in the Select a connection type list, select the IS16/M16/Evaluation Kit USB connection.

![Figure 13: Connection dialog box](image2)

6. In the product list, select the product and click the Connect button.
The main window displays the detections (green lines) in the segments (white lines).

![Figure 14: Main window](image)

A complete description of Leddar™ Configurator features and parameters for the M16 LSR can be found in chapter 5.
3. Measurements and Settings

This chapter presents measurements, settings, and zone definition for the M16 LSR.

3.1. Distance Measurement

Distance is measured from the base of the standoffs for the M16 LSR.

![Distance Measurement Diagram]

Figure 15: Distance measurement

The dashed lines illustrate 1 of the 16 segments and the solid line indicates the distance measured by the module in that segment.

3.2. Data Description

Data displayed in the Raw Detections dialog box allow the user to precisely define the desired detection parameters (View menu > Raw Detections).
An object crossing the beam of the module is detected and measured. It is qualified by its distance, segment position, and amplitude. The quantity of light reflected to the module by the object generates the amplitude. The bigger the reflection, the higher the amplitude will be.

The amplitude is expressed in counts. A count is the unit value of the used ADC in the receiver. The fractional of counts is caused by the accumulation to get more precision.

### Table 8: Raw Detection field description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment (Seg)</td>
<td>Beam segment in which the object is detected.</td>
</tr>
<tr>
<td>Distance</td>
<td>Position of the detected object.</td>
</tr>
<tr>
<td>Amplitude</td>
<td>Quantity of light reflected by the object and measured by the module.</td>
</tr>
<tr>
<td>Flags</td>
<td>8-bit status (bit field). See Table 9.</td>
</tr>
</tbody>
</table>
The **Flag** parameter provides the status information that indicates the measurement type.

### Table 9: Flag value description

<table>
<thead>
<tr>
<th>Bit position</th>
<th>Bit = 0</th>
<th>Bit = 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Invalid measurement.</td>
<td>Valid measurement.</td>
</tr>
<tr>
<td>1</td>
<td>Normal measurement.</td>
<td>Measurement is the result of demerging processing.</td>
</tr>
<tr>
<td>2</td>
<td>Normal measurement</td>
<td>Interference was detected in the current frame</td>
</tr>
<tr>
<td>3</td>
<td>Normal measurement.</td>
<td>Received signal is above the saturation level. Measurements are valid (VALID is set) but have a lower accuracy and precision. Consider decreasing the laser intensity value.</td>
</tr>
<tr>
<td>4</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
<tr>
<td>5</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
<tr>
<td>6</td>
<td>Normal measurement</td>
<td>Detection is within the crosstalk zone</td>
</tr>
<tr>
<td>7</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
</tbody>
</table>

The **Flag** field provisions for 8 bits encoded as a bit field. Three bits are currently used. The following table presents the implemented decimal values of the status bit field.

### Table 10: Status value description

<table>
<thead>
<tr>
<th>Status value (decimal)</th>
<th>Status value (binary)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>00000001</td>
<td>Normal measurement (valid).</td>
</tr>
<tr>
<td>9</td>
<td>00001001</td>
<td>Saturated signal (valid).</td>
</tr>
</tbody>
</table>
3.3. Acquisition Settings

Acquisition settings allow you to define parameters to use for detection.

To open the **Acquisition Settings** dialog box, select **Device > Configuration > Acquisition**.

3.3.1. General Settings

![Acquisition Settings dialog box](image)

**Figure 17: General tab – Acquisition Settings dialog box**

To apply new acquisition settings, click the apply button ✅ in the main window.
Table 11: Acquisition setting description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumulations</td>
<td>Number of accumulations. Higher values enhance range, reduce measurement rate and noise.</td>
<td>1, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>Oversampling</td>
<td>Number of oversampling cycles. Higher values enhance accuracy/range and reduce measurement rate.</td>
<td>1, 2, 4, 8</td>
</tr>
<tr>
<td>Point Count</td>
<td>Number of base sample points. Determines maximum detection range.</td>
<td>2 to 64</td>
</tr>
<tr>
<td>Approximate Range</td>
<td>Set the <strong>Point Count</strong> value using the up and down arrows to get the approximate range in meters or in feet.</td>
<td>Varies</td>
</tr>
<tr>
<td>Refresh Rate</td>
<td>The theoretical measurement rate indicated in Hertz.</td>
<td>Varies</td>
</tr>
<tr>
<td></td>
<td>The real measurement rate is indicated in the <strong>Device State</strong> window under <strong>View &gt; State</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Refer to section <strong>3.4 Measurement Rate</strong> for more details.</td>
<td></td>
</tr>
<tr>
<td>Threshold Offset</td>
<td>Modification to the amplitude threshold. Higher values decrease sensitivity and reduce range.</td>
<td>−5 to 100.00</td>
</tr>
<tr>
<td>Smoothing</td>
<td>Object smoothing algorithm. Smooths the module measurements. The behavior of the smoothing algorithm can be adjusted by a value ranging from −16 to 16. Higher values enhance the module precision but reduce the module reactivity. The smoothing algorithm can be deactivated by selecting the <strong>Disabled</strong> check box or entering −17 in the smoothing field.</td>
<td>−16 to 16 (Disabled at −17)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Range</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>LED Control (Laser Intensity)</strong></td>
<td>The measurement smoothing algorithm is advised for applications that need to measure slowly moving objects with a high precision. For the application requiring to quickly track moving objects, the smoothing should be configured with a value lower than 0 or simply deactivated.</td>
<td></td>
</tr>
<tr>
<td><strong>LED Control (Laser Intensity)</strong></td>
<td>Laser power control options. Selects between manual and automatic power control. In automatic, the laser power is adjusted according to incoming detection amplitudes. The current laser power level is visible in the View &gt; State &gt; Device State window.</td>
<td>100%</td>
</tr>
<tr>
<td><strong>Change Delay</strong></td>
<td>Minimum frame delay between power changes. Smaller numbers speed up the response time of the laser power adjustment.</td>
<td>Varies</td>
</tr>
<tr>
<td><strong>Object demerging</strong></td>
<td>Near-object discrimination. Eases the discrimination of multiple objects in the same segment. Object demerging is only available for a minimum of 8 oversampling and a minimum of 256 accumulations. The number of merged pulses that can be processed for each frame is also limited. A status field is available in the device states window (Leddar™ Configurator) indicating if the module processes all merged pulses. The measurement precision of demerged objects tends to be of less quality than on usual detections.</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Crosstalk Removal</strong></td>
<td>Inter-channel interference noise removal. Crosstalk is a phenomenon inherent to all multiple segments time-of-flight modules. It causes a degradation of the distance measurement accuracy of an object when one or more objects with significantly higher reflectivity are detected in other segments at a similar distance. This option enables an algorithm to compensate the degradation due to crosstalk. This algorithm increases the computational load of the module microcontroller. It is recommended to disable the crosstalk removal if the module is configured to run at rate higher than 50 Hz.</td>
<td>N/A</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Range</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Static Threshold</td>
<td>Static threshold is a default amplitude value (based on distance) under which detections are discarded to remove noise. It can be deactivated to gain more sensitivity.</td>
<td>Enable Disallow</td>
</tr>
<tr>
<td>Interference</td>
<td>When enabled, compares previous frame with current frame to detect false positive detections and discards them.</td>
<td>Enable Disallow</td>
</tr>
</tbody>
</table>

**Threshold offset**

The threshold offset is a value that modifies the detection amplitude threshold.

A default detection threshold table was determined to provide robust detection and minimize false detections caused by noise in the input signal.

Figure 18 presents the threshold table for a LED Intensity of 16. This table is effective when the threshold offset value is 0.

![Threshold for Oversampling 1](image1)

![Threshold for Oversampling 2](image2)

![Threshold for Oversampling 3](image3)

![Threshold for Oversampling 4](image4)

**Figure 18: Detection thresholds**

The multiple lines on each graph present the thresholds for a few accumulations of 1 (top curve), 2, 4, 8, 16, 32, 64, 128, and 256 (bottom curve). Accumulations of 512 and 1024 are also available, although not shown (provide the lowest thresholds).
The threshold offset parameter has the effect of offsetting each value in the threshold table by the selected value. This provides a means of reducing the sensitivity (positive value) or increasing the sensitivity (negative value) of the module. Increasing the value of the threshold offset allows ignoring (will not result in a measurement) signals with amplitude higher than the default threshold. Decreasing the value of the threshold offset allows measurements of amplitude signals lower than the default threshold.

NOTE: The default setting (0) is selected to ensure a very low occurrence of false measurements.

False measurements are likely to occur when reducing the threshold offset (negative values). These false measurements are very random in occurrence while true measurements are repeatable. For this reason, it may be useful in some applications to use a higher sensitivity and filter out the false measurements at the application level. For example, this can be useful in applications that require long detection ranges or detection of small or low reflectivity targets.

**Laser Intensity**

There are a total of 8 supported laser power levels. Their approximate relative power is as follows: 10%, 20%, 35%, 50%, 65%, 80%, 90% and 100%.

There are three power control modes:

- manual
- automatic mode 1
- automatic mode 2

With the manual mode, the light power source of the module is set to a fixed value. This mode can be used in a controlled environment of module FOV.

For automatic mode, the change delay defines the number of measurements required before allowing the module to increase or decrease by one the light source power level. For example, with the same change delay, the maximum rate of change (per second) of the light source power will be twice higher at 12.5 Hz than at 6.25 Hz. The change delay can be set by the number of detection frame and the number of segments in saturation mode can be tolerated (automatic mode 1 only).

The change delay defines the number of measurements required before allowing the module to increase or decrease by one the laser power level. For example, with the same change delay, the maximum rate of change (per second) of the laser power will be two times higher at 12.5 Hz than at 6.25 Hz.

NOTE: Since the change delay parameter is a number of measurements, the delay will vary if the measurement rate is changed (through modification of the accumulation and oversampling parameters).

Keeping the module in automatic laser power mode (default setting) ensures it adapts to varying environments. Close range objects may reflect so much light they can saturate the module, reducing the quality of the measurements. This mode will adapt the light output within the change delay setting to reach the optimal amplitude. On the other hand, low amplitudes provide lower accuracy and precision. The automatic laser power mode will select a laser intensity that provides the highest intensity to avoid the saturation condition.
This automatic light source power mode will select a light source intensity that provides the highest intensity that avoids the saturation condition. The automatic mode 2, will adapt the light output within the change delay (frame parameter only) to reach at least one or more segments in saturation condition to provide the highest detection range. This mode is useful to keep a highest detection range into non-saturated segments when a strongly reflective object is detected.

NOTE: When a strongly reflective or near object is present in the field of view while monitoring farther distances, the automatic adjustment will reduce the effective range of the module (reduced laser intensity value) and may prevent detection of long-range or low reflectivity objects. For these applications, manual mode with laser power set to 100% may be a better setting.

**Smoothing**

The smoothing algorithm increases the precision of the measurement at the cost of the module reactivity. The history length of the filter is defined as a function of the measurement noise level. It also changes according to the oversampling and accumulation settings. The history length of the averaging filter can also be adjusted by a parameter ranging from −16 to 16. Select the Disabled check box or set the value at −17 to disable smoothing. Higher values increase the module precision but reduce the module reactivity. An example of the behavior of the measurement smoothing algorithm is depicted in Figure 19.

![Figure 19: Measurement smoothing example](image)

The red line represents the true target distance; the blue curve corresponds to the target distance measured by the module without smoothing, while the green curve is the smoothed measurements. One could notice the measurement precision (standard deviation) is dramatically
improved by the smoothing algorithm.

**NOTE:** The smoothing algorithm is recommended for applications that need highly precise measurements of slowly moving objects. For applications that tracks quickly moving objects, it is advised to decrease the value of the smoothing parameter or to disable the smoothing algorithm. Select the **Disabled** check box or set the value at −17 to disable smoothing.

3.3.2. Enabling and Disabling Segments

To open the **Acquisition Settings** dialog box, select **Device > Configuration > Acquisition**.

Segments are enabled by default.

![Figure 20: Segments tab – Acquisition Settings dialog box](image)

When you uncheck segments, the corresponding segments will appear with gray square lines in the main window as shown in the image below.
To apply new acquisition settings, click the button in the main window.

3.3.3. Static threshold

Static threshold tab displays the current threshold applied in accordance with the acquisition settings.
The static threshold can be disabled in the General Acquisition Settings tab.

### 3.4. Measurement Rate

The module acquires an input waveform for each segment at a base rate.

**Table 12: Base rate**

<table>
<thead>
<tr>
<th>Product FOV Configuration</th>
<th>Base Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal</td>
<td>Vertical</td>
</tr>
<tr>
<td>19°</td>
<td>0.3°</td>
</tr>
<tr>
<td>19°</td>
<td>3°</td>
</tr>
</tbody>
</table>
Multiple acquisitions are used to perform accumulations and oversampling and generate a final waveform that is then processed to detect the presence of objects and measure their position.

The final measurement rate is therefore:

$$\text{Measurement rate} = \frac{\text{Base Rate}}{\text{accumulation} \times \text{oversampling}} \times \frac{8}{\text{Enabled segment pair}}$$

For example, with 256 accumulations and an oversampling value of 8, and a base rate of 6400 Hz with all segment pairs enabled:

$$\text{Measurement rate} = \frac{6400}{256 \times 8} \times \frac{8}{8} = 3.125 \text{ Hz}$$

Refer to section 3.3.2 Enabling and Disabling Segments for more details.

<table>
<thead>
<tr>
<th>Accumulation</th>
<th>Oversampling</th>
<th>Measurement Rate Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Base Rate 6 400 Hz</td>
</tr>
<tr>
<td>1 024</td>
<td>8</td>
<td>0.78125</td>
</tr>
<tr>
<td>512</td>
<td>8</td>
<td>1.5625</td>
</tr>
<tr>
<td>256</td>
<td>8</td>
<td>3.125</td>
</tr>
<tr>
<td>128</td>
<td>8</td>
<td>6.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>64</td>
<td>8</td>
<td>12.5</td>
</tr>
<tr>
<td>32</td>
<td>8</td>
<td>25</td>
</tr>
<tr>
<td>1024</td>
<td>4</td>
<td>1.5625</td>
</tr>
<tr>
<td>512</td>
<td>4</td>
<td>3.125</td>
</tr>
<tr>
<td>256</td>
<td>4</td>
<td>6.25</td>
</tr>
<tr>
<td>128</td>
<td>4</td>
<td>12.5</td>
</tr>
<tr>
<td>64</td>
<td>4</td>
<td>25</td>
</tr>
<tr>
<td>32</td>
<td>4</td>
<td>50</td>
</tr>
<tr>
<td>16</td>
<td>4</td>
<td>100</td>
</tr>
</tbody>
</table>
3.5. CPU Load

The measurement rate varies with the accumulations and oversampling settings. The higher the rate, the higher the processing load is on the source and control assembly microcontroller. The point count parameter also has an impact on the processing load since it impacts the number of sample points to process for each segment.

Given the high flexibility of parameter settings, it is possible to create a processing load that exceeds the capacity of the microcontroller. When the microcontroller load is exceeded, the theoretical measurement rate will not be obtained.

The load (CPU Load) is displayed in the Device State window (View menu > State). It is recommended to verify the load when modifying the accumulations, oversampling, and point count parameters. The measurement rate will be lower than the calculated rate and the measurement period may be irregular when the load nears or reaches 100%.

![Device State window](image)

**Figure 23: Device State window**

3.6. Serial Port Settings

Several serial port settings are available to adjust data acquisition through the RS-485 link. Typical serial port settings such as baud rate and start/stop bit can be configured to the desired values.

A baud rate of 115,200 bps is recommended to provide the best data transfer rate and measurement rate up to 50 Hz. The following serial port settings are configurable.
### Table 14: Serial port settings description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>Select 1 for the RS-485 port on the terminal block.</td>
</tr>
<tr>
<td></td>
<td>Select 2 for the expansion connector.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9 600 bps</td>
</tr>
<tr>
<td></td>
<td>19,200 bps</td>
</tr>
<tr>
<td></td>
<td>38,400 bps</td>
</tr>
<tr>
<td></td>
<td>57,600 bps</td>
</tr>
<tr>
<td></td>
<td>115,200 bps</td>
</tr>
<tr>
<td></td>
<td>230,400 bps(^1)</td>
</tr>
<tr>
<td></td>
<td>460,800 bps(^1)</td>
</tr>
<tr>
<td></td>
<td>921,600 bps(^1)</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Odd</td>
</tr>
<tr>
<td></td>
<td>Even</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Address</td>
<td>1 to 247</td>
</tr>
<tr>
<td>Detections(^2)</td>
<td>0 to 48</td>
</tr>
</tbody>
</table>

\(^1\) To avoid errors, it is recommended not to select these rates. Availability according to selected serial port.
\(^2\) This parameter can be limited to 40 if used with a 0x6A Modbus function.

The **Detections** parameter is the maximum number of detections to output in Modbus data transfers (Get Detections – function code 0x41). This can be used to match the data transfer rate to the module measurement rate (the module will drop measurements if the measurement rate exceeds the data transfer rate).

To give an equal chance to each segment, the module parses all segments to output their nearest measurement and then pass to the second nearest, etc. until either there are no more detections to output, or the configured number of detections is reached.

The following table lists the theoretical maximum number of detections that can be transferred for different baud rates and measurement rates. This assumes the host can sustain the resulting data transfer rate.
Table 15: Maximum detections per Baud rate/Measurement rate settings

<table>
<thead>
<tr>
<th>Baud Rate</th>
<th>Measurement Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.5625</td>
</tr>
<tr>
<td>921,600 bps*</td>
<td>48</td>
</tr>
<tr>
<td>460,800 bps*</td>
<td>48</td>
</tr>
<tr>
<td>230,400 bps*</td>
<td>48</td>
</tr>
<tr>
<td>115,200 bps</td>
<td>48</td>
</tr>
<tr>
<td>57,600 bps</td>
<td>48</td>
</tr>
<tr>
<td>38,400 bps</td>
<td>48</td>
</tr>
<tr>
<td>19,200 bps</td>
<td>48</td>
</tr>
<tr>
<td>9,600 bps</td>
<td>48</td>
</tr>
</tbody>
</table>

* To avoid errors, it is recommended not to select these rates. Availability according to selected serial port

3.7. CAN Port Settings

The CAN port settings are available to adjust data acquisition through the CAN link. Typical CAN port settings such as baud rate, Tx and Rx ID, frame format, inter-message and inter-cycle delay, flag information, maximum number of detection to output, and the message mode can be configured. The following CAN port settings are available.

Table 16: CAN port settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate</td>
<td>10, 20, 50, 100, 125, 250, 500, 1000 kbps.</td>
</tr>
<tr>
<td>Base Tx ID</td>
<td>The CAN arbitration ID used for data messages. From the module containing the detections. The arbitration ID of the messages containing the number of detections will be this value plus one (see the protocol documentation).</td>
</tr>
<tr>
<td>Base Rx ID</td>
<td>The CAN arbitration ID used for data messages to the evaluation kit (see the protocol documentation).</td>
</tr>
<tr>
<td>Frame Format</td>
<td>Standard, Extended.</td>
</tr>
<tr>
<td>Inter-Message Delay</td>
<td>0 to 65535 milliseconds.</td>
</tr>
<tr>
<td>Inter-Cycle Delay</td>
<td>0 to 65535 milliseconds.</td>
</tr>
<tr>
<td>Flag Information</td>
<td>Enable, Disable (standard detection message).</td>
</tr>
<tr>
<td>Detection</td>
<td>1 to 96.</td>
</tr>
<tr>
<td>Message Mode</td>
<td>Single or multiple.</td>
</tr>
</tbody>
</table>

The CAN port supports two frame format standards: the standard 11 identifier bits and the extended 29 identifier bits.
For a CAN host device that uses limited resources, it is possible to slow down the CAN data transmission by adding configurable delays from 0 to 65535 milliseconds:

The **Inter-Message Delay** parameter is a delay to add between two CAN messages.

The **Inter-Cycle Delay** parameter is a delay to add between two acquisition cycles message block. It is especially used to send detection in continuous mode.

The **Flag Information** parameter, when activated, gives an 8-bit field additional information of measurement.

The **Detections** parameters is the maximum number of detections to output in the CAN bus. This can be used to limit the range of message ID used in multiple message mode. In order to give an equal chance to each segment, the module parses all segments to output their nearest measurement and then move to the next nearest, and so on until either there are no more detections to output or the configured number of detections is reached.

The **Message Mode** parameter is the type of transmission data on the CAN link. Two message modes are available. Please refer to section 4.2 for more information.
4. Communication

4.1. Serial Port

The RS-485 port on the module uses the Modbus protocol using RTU transmission mode only. This section describes the commands that are implemented.

For more information on the Modbus protocol, please visit [www.modbus.org](http://www.modbus.org).

Report server ID (function code 0x11)

This function returns information on the module in the following format:

**Table 17: Report server ID message**

<table>
<thead>
<tr>
<th>Offset</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>Number of bytes of information (excluding this one). Currently 0x95 since the size of information returned is fixed.</td>
</tr>
<tr>
<td>1</td>
<td>32</td>
<td>Serial number as an ASCII string.</td>
</tr>
<tr>
<td>33</td>
<td>1</td>
<td>Run status 0: OFF, 0xFF:ON. Should always return 0xFF, otherwise the module is defective.</td>
</tr>
<tr>
<td>34</td>
<td>64</td>
<td>The device name as a Unicode string.</td>
</tr>
<tr>
<td>98</td>
<td>16</td>
<td>The software part number as an ASCII string.</td>
</tr>
<tr>
<td>114</td>
<td>16</td>
<td>The hardware part number as an ASCII string.</td>
</tr>
<tr>
<td>130</td>
<td>8</td>
<td>The full firmware version as 4 16-bit values.</td>
</tr>
<tr>
<td>138</td>
<td>4</td>
<td>The firmware 32-bit CRC.</td>
</tr>
<tr>
<td>142</td>
<td>2</td>
<td>The firmware type (LeddarTech internal use).</td>
</tr>
<tr>
<td>144</td>
<td>2</td>
<td>The FPGA version.</td>
</tr>
<tr>
<td>146</td>
<td>4</td>
<td>Device option flags (LeddarTech internal use).</td>
</tr>
<tr>
<td>150</td>
<td>2</td>
<td>Device identification code (14 for M16 Laser module).</td>
</tr>
</tbody>
</table>

Get detections (function code 0x41)

This function returns the detections/measurements in the following format:

The first byte is the number of detections in the message. Because of the limitation on a Modbus message length, a maximum of 48 detections will be returned. This is not a problem as it is very unlikely to have more than 48 detections in a real-world application.

**NOTE:** This maximum can be configured to a lower value using the Leddar™ Configurator software (serial port configuration) or the Write Register command described below.

Following the first byte, each detection has five bytes:
Table 18: Get detection message (detection fields)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2</td>
<td>The distance in centimeters (little-endian). Distance unit is defined by holding register 14.</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>The amplitude times 64 (that is, amplitude = this field/64)(little-endian).</td>
</tr>
</tbody>
</table>
| 4      | 1      | Low 4 bits are flags describing the measurement:
|        |        | Bit 0 - Detection is valid (will always be set) |
|        |        | Bit 1 - Detection was the result of object demerging |
|        |        | Bit 2 - Interference was detected in the current frame |
|        |        | Bit 3 - Detection is saturated |
|        |        | High 4 bits are the segment number. |

Three more data fields follow the detection list:

Table 19: Get detection message (trailing fields)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>4</td>
<td>Timestamp of the acquisition (little-endian). The timestamp is expressed as the number of milliseconds since the device was started.</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Current laser power as a percentage of maximum.</td>
</tr>
</tbody>
</table>
| 5      | 1      | Current acquisition statuses. This is an 8-bit:
|        |        | Bit 0 – Reserved |
|        |        | Bit 1 – Object demerging is completed if 1 when this function is activated. |
|        |        | Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode). This field is valid only if failsafe product option is available. |

For an example of a 0x41 Modbus function (user defined), refer to Appendix A

Get detections and flags info (function code 0x6A)

This function returns the detections/measurements in the following format:

The first byte is the number of detections in the message. Because of the limitation on a Modbus message length, a maximum of 40 detections will be returned.

NOTE: This maximum can be configured to a lower value using the Leddar™ Configurator software (serial port configuration) or the Write Register command described below. This configuration parameter is same as original “Get detection” (0x41) function but if it is over than 40 detections, it will be internally overriding to a maximum of 40 detections for this “Get detection and flags info” (0x6A) function.

Following the first byte, each detection has six bytes:
Table 20: Get detection message (detection fields)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2</td>
<td>The distance in centimeters (little-endian). Distance unit is defined by holding register 14.</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>The amplitude times 64 (that is, amplitude = this field/64)(little-endian)</td>
</tr>
</tbody>
</table>
| 4      | 1      | 4 bits are flags describing the measurement (all others are reserved): \  
  Bit 0 - Detection is valid (will always be set) \  
  Bit 1 - Detection is the result of object demerging \  
  Bit 2 - Interference was detected in the current frame \  
  Bit 3 - Detection is saturated \  
  Bit 6 - Detection is within the crosstalk zone |
| 5      | 1      | Segment number.                                                                                                                              |

Three more data fields follow the detection list:

Table 21: Get detection message (trailing fields)

<table>
<thead>
<tr>
<th>Offset</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>4</td>
<td>Timestamp of the acquisition (little-endian). The timestamp is expressed as the number of milliseconds since the device was started.</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Current laser power as a percentage of maximum.</td>
</tr>
</tbody>
</table>
| 5      | 1      | Current acquisition statuses. This is an 8-bit: \  
  Bit 0 – Reserved \  
  Bit 1 - Object demerging is completed if 1 when this function is activated. \  
  Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode). This field is valid only if failsafe product option is available. |
Read input register (function code 0x4)

Table 22 presents the registers implemented for this command.

Table 22: Read input register message

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Module temperature in degree Celsius. Fixed point value with an 8-bit fractional part (that is, temperature is the register value divided by 256).</td>
</tr>
</tbody>
</table>
| 1       | Detection status for polling mode:  
          0 = Detections not ready.  
          1 = Detections ready: this register is reset to 0 on reading input registers from addresses 13 to 207 or on execution of “get detections” function (code 0x41 or 0x6A). |
| 2       | Detection zone outputs bitfield (1 zone per bit).  
          Bit 0 – Object in advanced detection zone (0 = no detection in advanced detection zone, 1 = detection in advanced detection zone). Only this zone is currently available. |
| 13      | Least significant byte is the current LED power as a percentage of maximum. Most significant byte is acquisition statuses: This is an 8-bit:  
          Bit 0 – Reserved  
          Bit 1 - Object demerging is completed if 1 when this function is activated.  
          Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode). This field is valid only if failsafe product option is available. |
| 14      | Low 16 bits of timestamp (number of milliseconds since the module was started). |
| 15      | High 16 bits of timestamp. |
| 16-31   | Distance in centimeters of first detection for each segment, zero if no detection in a segment. Distance unit is defined by holding register 14. |
| 32-47   | Amplitude of first detection for each segment times 64 (that is, amplitude = this register/64), zero if no detection in a segment. |
| 48-63   | Distance of second detection for each segment. |
| 64-79   | Amplitude of second detection for each segment. |
| 80-95   | Distance of third detection. |
| 96-111  | Amplitude of third detection. |
| 112-127 | Distance of fourth detection. |
| 128-143 | Amplitude of fourth detection. |
| 208     | Least significant byte is the current LED power as a percentage of maximum. Most significant byte is acquisition statuses: This is an 8-bit:  
          Bit 0 – Reserved  
          Bit 1 - Object demerging is completed if 1 when this function is activated. |
<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode). This field is valid only if failsafe product option is available.</td>
</tr>
<tr>
<td>210</td>
<td>Low 16 bits of timestamp (number of milliseconds since the module was started). This register content is same as input register 14.</td>
</tr>
<tr>
<td>211-226</td>
<td>Distance in centimeters of first detection for each segment, zero if no detection in a segment. Distance unit is defined by holding register 14.</td>
</tr>
<tr>
<td>227-242</td>
<td>Amplitude of first detection for each segment times 64 (that is, amplitude = this register/64), zero if no detection in a segment.</td>
</tr>
<tr>
<td>243-258</td>
<td>Flags of first detection for each segment, refer to Table 3 and Table 37.</td>
</tr>
<tr>
<td>259-274</td>
<td>Distance of second detection for each segment.</td>
</tr>
<tr>
<td>275-290</td>
<td>Amplitude of second detection for each segment.</td>
</tr>
<tr>
<td>291-306</td>
<td>Flags of second detection for each segment.</td>
</tr>
<tr>
<td>307-322</td>
<td>Distance of third detection.</td>
</tr>
<tr>
<td>323-338</td>
<td>Amplitude of third detection.</td>
</tr>
<tr>
<td>339-354</td>
<td>Flags of third detection.</td>
</tr>
<tr>
<td>355-370</td>
<td>Distance of fourth detection.</td>
</tr>
<tr>
<td>371-386</td>
<td>Amplitude of fourth detection.</td>
</tr>
<tr>
<td>387-402</td>
<td>Flags of fourth detection.</td>
</tr>
</tbody>
</table>

**NOTE:** As per the Modbus protocol, register values are returned in big-endian format.

For an example of a 0x04 Modbus function (read input register), refer to Appendix B.
Read holding register (function code 0x3), write register (function code 0x6) and write multiple register (function code 0x10)

Table 23 presents the registers implemented for these commands (see section 3.3 for a more detailed description of parameters).

**Table 23: Read holding register message definition**

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Exponent for the number of accumulation (that is, if the content of this register is n, (2^n) accumulations are performed).</td>
</tr>
<tr>
<td>1</td>
<td>Exponent for the number of oversampling (that is, if the content of this register is n, (2^n) oversamplings are performed).</td>
</tr>
<tr>
<td>2</td>
<td>Number of base samples.</td>
</tr>
<tr>
<td>3</td>
<td>Reserved.</td>
</tr>
<tr>
<td>4</td>
<td>Detection threshold as a fixed-point value with an 8-bit fractional part (that is, threshold value is this register divided by 256). The range is limited to a maximum of 100.0 and to a variable minimum determined by the accumulation and oversampling settings (read back the register to know the actual value set).</td>
</tr>
<tr>
<td>5</td>
<td>Laser power in percentage of the maximum. A value above 100 is an error. Only the laser intensity values defined in section 3.3 should be used. If a value is specified that is not one of the pre-defined values, the closest pre-defined value will be used. The register can be read back to know the actual value set.</td>
</tr>
<tr>
<td>6</td>
<td>Bit field of acquisition options with 6 bits currently defined (all others are reserved): Bit 0 – Automatic laser intensity enabled Bit 2 – Object demerging enabled Bit 3 – Crosstalk removal disabled (disabled if 1) Bit 8 – Automatic laser intensity mode: 0 = Mode 1 1 = Mode 2 Bit 9 – Disable the static detection threshold table usage Bit 10 – Enable interference algorithm</td>
</tr>
<tr>
<td>7</td>
<td>Change delay in number of measurements.</td>
</tr>
<tr>
<td>8</td>
<td>Maximum number of detections (measurements) returned by function 0x41 and 0x6A*. * Can be limited to 40 if used with a 0x6A Modbus function.</td>
</tr>
<tr>
<td>9 and 10</td>
<td>Reserved</td>
</tr>
<tr>
<td>11</td>
<td>Smoothing: Stabilizes the module measurements. The behavior of the smoothing algorithm can be adjusted by a value ranging from –16 to 16. Select the <strong>Disabled</strong> check box or set the value at –17 to disable smoothing.</td>
</tr>
<tr>
<td>12 and 13</td>
<td>Reserved</td>
</tr>
<tr>
<td>14</td>
<td>Distance units: mm = 1000 cm = 100 dm = 10</td>
</tr>
<tr>
<td>Address</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>m = 1</td>
<td>Communication segment activation: Bits field of selected segment to activate.</td>
</tr>
<tr>
<td>15</td>
<td>Bit field for test mode (if failsafe product option is available): Bit 0 – Test mode activation (0 = OFF, 1 = ON), volatile setting to default OFF state.</td>
</tr>
<tr>
<td>16</td>
<td>Reserved.</td>
</tr>
<tr>
<td>17</td>
<td>Acquisition segment pair activation: bits field of selected segment pair to activate.</td>
</tr>
<tr>
<td>18</td>
<td>Reserved.</td>
</tr>
<tr>
<td>19 to 26</td>
<td>Reserved.</td>
</tr>
<tr>
<td>27</td>
<td>Port configuration stop bits: Set to 1 or 2.</td>
</tr>
<tr>
<td>28</td>
<td>Port configuration parity: 0 = none 1 = odd 2 = even</td>
</tr>
<tr>
<td>29</td>
<td>Port configuration Baud rate: 0 = 9 600 bps 1 = 19,200 bps 2 = 38,400 bps 3 = 57,600 bps 4 = 115,200 bps 5 = 230,400 bps* 6 = 460,800 bps* 7 = 921,600 bps*</td>
</tr>
<tr>
<td>30</td>
<td>Port configuration Modbus module address: Set from 1 to 247.</td>
</tr>
</tbody>
</table>

* To avoid errors, it is recommended not to select these rates. Availability according to selected serial port.

To set up the port configuration, it is recommended to do a “read holding registers“ and “write multiple register“ commands for the entire range of Modbus holding register address from 27 to 30 inclusively.

The write register and write multiple register command execution will fail if this module is USB connected to a host device; the error code 4 will be returned.

**NOTE:** As per the Modbus protocol, register values are returned in big-endian format.

A request for a register that does not exist will return error code 2. Trying to set up a register to an invalid value will return error code 3. If an error occurs while trying to execute the function, error code 4 will be returned.

### 4.2. CAN Bus

The CAN bus in single message mode uses the 1872 (0x750) base ID to send all detection message. When sending detection, one 0x751 message will be sent followed by as many 1872 (0x750) base ID messages as needed.
The CAN port in multiple message mode uses a maximum range from 1874 (0x752) ID to 1922 (0x782) of standard message or a maximum range from 1874 (0x752) ID to 1970 (0x7B2) of message with detection flag information. When sending detection, one 0x751 message will be sent followed by messages on ID range from 1874 (0x752) to as needed in multiple message mode.

Four message IDs are available (these IDs can be modified with the Leddar™ Configurator software).

1856 (0x740) (Rx base ID)

This is an 8-byte message length for command request that the module listens for: the first byte (Byte 0) describe the main function and rest of message bytes are used as arguments. Undescribed bytes are reserved and must be set to 0.

Table 24: CAN bus request message

<table>
<thead>
<tr>
<th>Function Request (Byte 0)</th>
<th>Function Request Description</th>
<th>Function Arguments (Byte 1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Legacy: Send detections once</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Legacy: Start sending detections continuously (the module will send a new set of detections each time they are ready without waiting for a request).</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Stop sending detections continuously.</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Send detection once.</td>
<td>Bit field of operation mode (this override CAN Operation Mode field in CAN port configuration 3):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-0: 0 = return detection in single message mode, 1 = return detection in multiple message mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-1: reserved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-2: reserved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-3: detection flag message activation</td>
</tr>
<tr>
<td>5</td>
<td>Start sending detections continuously (that is, the module will send a new set of detections each time they are ready without waiting for a request).</td>
<td>Bit field of operation mode (this override CAN Operation Mode field in CAN port configuration 3):</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-0: 0 = return detection in single message mode, 1 = return detection in multiple message mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-1: reserved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-2: reserved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit-3: detection flag message activation</td>
</tr>
<tr>
<td>6</td>
<td>GET input data (read only).</td>
<td>See Table 25.</td>
</tr>
<tr>
<td>7</td>
<td>GET holding data</td>
<td>See Table 26.</td>
</tr>
</tbody>
</table>
**NOTE:** The GET and SET function messages always return an answer message on the 1873 (0x751) base ID, see section below.

**Table 25: CAN bus request message (GET input data)**

<table>
<thead>
<tr>
<th>Input Data Type (Byte 1)</th>
<th>Input Data Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Temperature</td>
</tr>
<tr>
<td>1</td>
<td>Device identification and option</td>
</tr>
<tr>
<td>2</td>
<td>Firmware version</td>
</tr>
<tr>
<td>3</td>
<td>FPGA version</td>
</tr>
<tr>
<td>4 to 9</td>
<td>Serial number</td>
</tr>
<tr>
<td>10 to 20</td>
<td>Device name</td>
</tr>
<tr>
<td>21 to 23</td>
<td>Software part number</td>
</tr>
<tr>
<td>24 to 26</td>
<td>Hardware part number</td>
</tr>
<tr>
<td>27</td>
<td>Detection zone</td>
</tr>
</tbody>
</table>

**Table 26: CAN bus request message (GET holding data)**

<table>
<thead>
<tr>
<th>Holding Data Type (Byte 1)</th>
<th>Holding Data Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Acquisition configuration</td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>Detection threshold</td>
</tr>
<tr>
<td>3</td>
<td>Laser power percent (%)</td>
</tr>
<tr>
<td>4</td>
<td>Acquisition option</td>
</tr>
<tr>
<td>5</td>
<td>Auto acquisition average frames</td>
</tr>
<tr>
<td>6</td>
<td>Smoothing</td>
</tr>
<tr>
<td>7</td>
<td>Distance resolution</td>
</tr>
<tr>
<td>8</td>
<td>Communication segment enable</td>
</tr>
<tr>
<td>9</td>
<td>CAN port configuration 1</td>
</tr>
<tr>
<td>10</td>
<td>CAN port configuration 2</td>
</tr>
<tr>
<td>11</td>
<td>CAN port configuration 3</td>
</tr>
<tr>
<td>12</td>
<td>Test mode</td>
</tr>
<tr>
<td>13</td>
<td>Reserved</td>
</tr>
<tr>
<td>14</td>
<td>Acquisition segment pair enable</td>
</tr>
</tbody>
</table>
Table 27: CAN bus request message (SET holding data)

<table>
<thead>
<tr>
<th>Holding Data Type (Byte 1)</th>
<th>Holding Data Description</th>
<th>Argument</th>
<th>Arguments Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Acquisition configuration</td>
<td>Byte 2</td>
<td>Exponent for the number of accumulation (that is, if the content of this register is ( n ), ( 2^n ) accumulations are performed).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td>Exponent for the number of oversampling (that is, if the content of this register is ( n ), ( 2^n ) oversamplings are performed).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 4</td>
<td>Number of base samples.</td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>Detection threshold</td>
<td>Byte 4</td>
<td>Detection threshold as a fixed-point value with a 19-bit fractional part (that is, threshold value is this register divided by 524288).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td>The range is limited to a maximum of 100.0 and to a variable minimum determined by the accumulations and oversampling (read back the register to know the actual value).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Laser power percent (%)</td>
<td>Byte 2</td>
<td>Laser power in percentage of the maximum.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A value above 100 is an error. Only the laser intensity values defined in section 3.3 should be used. If a value is specified that is not one of the predefined values, the closest predefined value will be used. The register can be read back to know the actual value set. Note that this value is ignored if the automatic laser intensity is enabled.</td>
</tr>
<tr>
<td>4</td>
<td>Acquisition option</td>
<td>Byte 2</td>
<td>Bit field of acquisition options with 4 bits currently defined (all others are reserved): Bit 0 – Automatic laser intensity enabled Bit 2 – Object demerging enabled Bit 3 – Crosstalk removal disable (disable if 1) Bit 8 – Automatic laser intensity mode: ( 0 ) = Mode 1 ( 1 ) = Mode 2 Bit 9 – Disable the static detection threshold table usage Bit 10 – Enable interference algorithm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td>Change delay in number of measurements.</td>
</tr>
<tr>
<td>Holding Data Type (Byte 1)</td>
<td>Holding Data Description</td>
<td>Argument</td>
<td>Arguments Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------</td>
<td>----------</td>
<td>-----------------------</td>
</tr>
<tr>
<td></td>
<td>Auto acquisition average frames</td>
<td>Byte 3</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Smoothing</td>
<td>Byte 2</td>
<td>Smoothing: stabilizes the module measurements. The behavior of the smoothing algorithm can be adjusted by a value ranging from -16 to 16. Select the Disabled check box or set the value at -17 to disable smoothing.</td>
</tr>
<tr>
<td>7</td>
<td>Distance units</td>
<td>Byte 2</td>
<td>Distance units: mm = 1000 cm = 100 dm = 10 m = 1</td>
</tr>
<tr>
<td>8</td>
<td>Communication segment enable</td>
<td>Byte 2</td>
<td>Bits field of activated segment for communication.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td>Baud rate: 0 = 1000 kbps 1 = 500 kbps 2 = 250 kbps 3 = 125 kbps 4 = 100 kbps 5 = 50 kbps 6 = 20 kbps 7 = 10 kbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td>Frame format: 0 = standard 11 bits 1 = extended 29 bits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 4</td>
<td>Tx base ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>CAN port configuration 2</td>
<td>Byte 4</td>
<td>Rx base ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>Holding Data Type (Byte 1)</td>
<td>Holding Data Description</td>
<td>Argument</td>
<td>Arguments Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------</td>
<td>----------</td>
<td>-----------------------</td>
</tr>
</tbody>
</table>
| 11                        | CAN port configuration 3 | Byte 2   | CAN Operation Mode bits field:  
|                           |                          |          | Bit-0: 0 = return detection in single message mode, 1 = return detection in multiple message mode  
|                           |                          |          | Bit-1: inter-message delay activation  
|                           |                          |          | Bit-2: inter-cycle delay activation  
|                           |                          |          | Bit-3: detection flag message activation  
|                           |                          | Byte 3   | Maximum number of detections (measurements) returned per CAN detection message transaction: 1 to 96.  
|                           |                          | Byte 4   | Inter-message delay 0 to 65535 milliseconds.  
|                           |                          | Byte 5   |  
|                           |                          | Byte 6   | Inter-cycle delay 0 to 65535 milliseconds.  
|                           |                          | Byte 7   |  
| 12                        | Test mode                | Byte 2   | Bit field for test mode (if failsafe product option is available):  
|                           |                          |          | Bit 0 – Test mode activation (0 = OFF, 1 = ON), volatile setting to default OFF state.  
| 13                        | Reserved                 | -        | -  
| 14                        | Acquisition segment pair enable | Byte 2  | Bits field of segment pair enable for acquisition.  
|                           |                          | Byte 3   |  

**NOTE:** The SET command execution will fail if this module is USB connected to a host device: an error answer message will be returned.

**1873 (0x751) (Tx Base ID + 1)**

This is an 8-byte message that indicates: the number of detections that will be sent or the answer to the GET and SET command requests.

**Table 28: CAN bus answer message**

<table>
<thead>
<tr>
<th>Answer Data (Byte 0)</th>
<th>Answer Data Description</th>
<th>Additional Answer Data (Byte 1 to Byte 7)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal or less than 96</td>
<td>Number of detections.</td>
<td>See Table 29.</td>
</tr>
<tr>
<td>Answer Data (Byte 0)</td>
<td>Answer Data Description</td>
<td>Additional Answer Data (Byte 1 to Byte 7)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>------------------------------------------</td>
</tr>
</tbody>
</table>
| 128 + 6             | Answer to GET input data request. | Success: See format in Table 30.  
Fail: All byte 2 to byte 7 are set to 0xFF. |
| 128 + 7             | Answer to GET holding data request. | Success: See format in Table 27.  
Fail: All byte 2 to byte 7 are set to 0xFF. |
| 128 + 8             | Answer to SET holding data request. | Success: Return echo of the SET command request.  
Fail: All byte 2 to byte 7 are set to 0xFF. |

**Table 29: CAN bus number of detection message**

<table>
<thead>
<tr>
<th>Data</th>
<th>Data Return Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 0</td>
<td>Number of detections.</td>
</tr>
<tr>
<td>Byte 1</td>
<td>Reserved.</td>
</tr>
<tr>
<td>Byte 2</td>
<td>Current laser power as a percentage of maximum.</td>
</tr>
</tbody>
</table>
| Byte 3 | Current acquisition statuses. This is an 8-bit field:  
Bit 0 – Reserved  
Bit 1 – Object demerging is completed if set to 1 when this function is activated.  
Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode).  
This field is valid only if failsafe product option is available. |
| Byte 4 |  |
| Byte 5 |  |
| Byte 6 |  |
| Byte 7 | Timestamp of the acquisition. The timestamp is expressed as the number of milliseconds since the module was started. |
Table 30: CAN bus answer message (GET input data)

<table>
<thead>
<tr>
<th>Input Data Type (Byte 1)</th>
<th>Input Data Description</th>
<th>Arguments</th>
<th>Arguments Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Temperature</td>
<td>Byte 4</td>
<td>Temperature as a fixed-point value with a 16-bits fractional part (that is, temperature value is this register divided by 65536).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Device identification and options</td>
<td>Byte 2</td>
<td>Device identification code (14 for M16 Laser module).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 4</td>
<td>Device option flags (LeddarTech internal use).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Firmware version</td>
<td>Byte 2</td>
<td>The firmware build version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 4</td>
<td>The firmware 32-bit CRC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 7</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>FPGA version</td>
<td>Byte 2</td>
<td>The FPGA version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 4</td>
<td>The firmware type (LeddarTech internal use).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Byte 6</td>
<td>Run status 0: OFF, 0xFF:ON. Should always return 0xFF, otherwise the module is defective.</td>
</tr>
<tr>
<td>4 to 9</td>
<td>Serial number</td>
<td>Byte 2 to Byte 7</td>
<td>Serial number as an ASCII string (max 32 bytes).</td>
</tr>
<tr>
<td>10 to 20</td>
<td>Device name</td>
<td>Byte 2 to Byte 7</td>
<td>The device name as a Unicode string (max 64 bytes).</td>
</tr>
<tr>
<td>21 to 23</td>
<td>Software part number</td>
<td>Byte 2 to Byte 7</td>
<td>The software part number as an ASCII string (max 16 bytes)</td>
</tr>
<tr>
<td>24 to 26</td>
<td>Hardware part number</td>
<td>Byte 2 to Byte 7</td>
<td>The hardware part number as an ASCII string (max 16 bytes).</td>
</tr>
<tr>
<td>27</td>
<td>Detection zone</td>
<td>Byte 2</td>
<td></td>
</tr>
</tbody>
</table>
Byte 3
Detection zone outputs bitfield (1 zone per bit).
Bit 0 – Object in advanced detection zone
(0 = no detection in advanced detection zone, 1 = detection in advanced detection zone). Only this zone is currently available.

| Byte 4 | Reserved |
| Byte 5 |
| Byte 6 |
| Byte 7 |

**1872 (0x750) (Tx base ID)**

This is an 8-byte message containing detection use in single message mode. Two types of message are supported: standard detection message and detection message with flag information.

The standard detection message containing two detections: if the number of detections is odd, the last message will be 0 filled in the last 4 bytes. The message is separated in two parts with the same format:

Data bytes 0 and 1 contain the distance in units defined by “distance units” holding data.

Data byte 2 and the 4 LSBs of byte 3 contain the amplitude as a 12-bit value. This value must be divided by 4 to get the amplitude (that is, 2 bits for fractional part).

The 4 MSBs of byte 3 contain the segment number.

**Table 31: Standard CAN bus detection message**

<table>
<thead>
<tr>
<th>Byte 7</th>
<th>Byte 6</th>
<th>Byte 5</th>
<th>Byte 4</th>
<th>Byte 3</th>
<th>Byte 2</th>
<th>Byte 1</th>
<th>Byte 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment</td>
<td>Amplitude</td>
<td>Distance</td>
<td>Segment</td>
<td>Amplitude</td>
<td>Distance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(n+1)</td>
<td>(n+1)</td>
<td>(n+1)</td>
<td>(n)</td>
<td>(n)</td>
<td>(n)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The detection message with flag information containing only one detection and the format is as below:

Data bytes 0 and 1 contain the distance in units defined by “distance units” holding data.

Data bytes 2 and 3 contain the amplitude. This value must be divided by 64 to get the amplitude (that is, 6 bits for fractional part).

The byte 4 contains the flag information as described in Table 32.

**Table 32: Flag information of measurement**

<p>| Bit 0 | Detection is valid (will always be set) |</p>
<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Detection was the result of object demerging</td>
</tr>
<tr>
<td>2</td>
<td>Interference was detected in the current frame</td>
</tr>
<tr>
<td>3</td>
<td>Detection is saturated</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>Reserved</td>
</tr>
<tr>
<td>6</td>
<td>Detection is within the crosstalk zone</td>
</tr>
<tr>
<td>7</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The byte 5 contains the segment number.
Data bytes 6 and 7 are reserved.

Table 33: CAN bus detection message definition with flag information

<table>
<thead>
<tr>
<th>Byte 7</th>
<th>Byte 6</th>
<th>Byte 5</th>
<th>Byte 4</th>
<th>Byte 3</th>
<th>Byte 2</th>
<th>Byte 1</th>
<th>Byte 0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Segment (n)</td>
<td>Flag (n)</td>
<td>Amplitude (n)</td>
<td>Distance (n)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1874 (0x752) (Tx base ID + 2)

This is an 8-byte message for multiple message mode using the same format as 0x750 message (see above). Detections are sent on a message ID range from 1874 to [1874 + (number of detections / 2) + (number of detections MODULO 2)] in standard detection message and send on a message ID range from 1874 to [1874 + number of detections] in detection message with flag information. The range of message ID can be limited by the maximum amount of detection to output to CAN port.

Example: Module with 1874 base ID: 19 detections are sent.
- From 1874 to 1884 message ID in standard detection message.
- From 1874 to 1882 message ID in standard detection message on a module setup of 16 maximum amount of detection.
- From 1874 to 1893 message ID in detection message with flag information.
- From 1874 to 1890 message ID in detection message with flag information on a module setup of 16 maximum amount of detection.

For an example of a CAN bus detection request, refer to Appendix C.
5. **Leddar™ Configurator**

The Leddar™ Configurator provides configuration parameters and operation functionalities for Leddar™ products.

5.1. **Introduction**

The Configurator interface can be resized manually or set to full-screen view.

All dialog boxes that do not include a selection of action buttons at the bottom, such as Connect, OK, Cancel, etc. are dockable at the top, the bottom, or on the right side of the main window.

![Raw Detections dialog box docked on the side of the main window](image)

When a dialog box or a window is already open a check mark appears next to the command on the menu.

5.2. **Connection Window**

The following is a description of the information shown in the Connection dialog box.
Select a connection Type

The connection type you are using.

The device list, in the center of the **Connection** dialog box, displays the devices currently detected.

Name

The device name can be modified (see section 5.4.1 Device Name).

Serial Number

The serial number of the device as assigned by LeddarTech®.

Type

The product name.

5.3. LeddarTM Configurator Main Window

After connecting to the device, the main window opens.
The measurements are plotted in a symbolic graph containing the 16 segments (white lines) originating from the module. Detections are drawn as arcs in their corresponding segments. Only valid measurements are displayed. A more detailed description of the measurements can be obtained in the Raw Detections dialog box (see section 5.11 Raw Detections).

The X and Y numbers displayed at the bottom are the mouse cursor position coordinates.

5.3.1. Toolbar Display Controls

The toolbar includes several buttons for adjusting the view of the main window display.

5.3.2. Fit to Window

When the equal scaling button \( \frac{1}{1} \) is selected (button highlighted), the original ratio of the display is kept or restored. The horizontal and vertical scales will be set to the same values and the beam will be displayed in accordance with the beam properties (for example, the display will show a 48° beam for a 48° module).

Click the button again to change the vertical and horizontal scales independently.

**NOTE:** When in equal scaling mode, you cannot zoom the display horizontally or vertically, that is, holding the <Control> or <Shift> key down while zooming in or out will have no effect. The scales cannot then be modified by entering values in the fields shown in Figure 25 above.
5.3.3. Force Equal Horizontal and Vertical Scales

When the equal scaling button is selected (button highlighted), the original ratio of the display is kept or restored. The horizontal and vertical scales will be set to the same values and the beam will be displayed in accordance with the beam properties (for example, the display will show a 48° beam for a 48° module).

Click the button again to change the vertical and horizontal scales independently.

**NOTE:** When in equal scaling mode, you cannot zoom the display horizontally or vertically, that is, holding the <Control> or <Shift> key down while zooming in or out will have no effect. The scales cannot then be modified by entering values in the fields shown in Figure 2 above.

5.3.4. Zoom In

Click the zoom in button to zoom in vertically and horizontally around the center of the display.

5.3.5. Zoom Out

Click the zoom out button to zoom out vertically and horizontally around the center of the display.

5.3.6. Scale

The window opens with the default scale setting. The horizontal and vertical scales can be changed manually by entering new values in the fields accessible by clicking the areas shown in Figure 25 above.

To apply the changes, click anywhere in the main window.

5.3.7. Panning and Zooming

The display in the main window can be panned and zoomed in different ways. Panning and zooming is done relative to the mouse cursor position.

You can move up, down, and sideways by clicking and dragging the display.

To zoom the display in and out, use the mouse wheel alone. This has the same effect as clicking the zoom in or zoom out button respectively (see sections 5.3.4 and 5.3.5).

To zoom the display horizontally, hold the <Control> key of the computer keyboard down while using the mouse wheel.

**NOTE:** The equal scaling button must not be selected (not highlighted).
To zoom the display vertically, hold the <Shift> key down while using the mouse wheel.

**NOTE:** The equal scaling button must not be selected (not highlighted).

The measurements of a detection point appear as a pop-up when you point to it with the mouse cursor for a more accurate assessment of the detection. Detection points are shown in the form of green lines (arcs) in the main window for visibility reasons.
5.3.8. Changing the Module Origin

The module origin can be modified by clicking the module origin at the bottom of the segments.

To do so, use the mouse cursor to point to the bottom of the segments (a red dot appears); click and drag it in the desired position.

If you click and drag the module origin, the module position is displayed in the status bar as shown in Figure 30 below.
To apply the changes, click the apply button.

The module origin is saved in the module and can also be modified by editing the parameters in the module position settings window (see section 5.4.3 Module Position).

**5.3.9. Changing the Module Orientation**

The module origin may be rotated to match the physical position of the module. If you do so, the main window display can better match the physical installation of the module. For example, if the module is installed above the ground, the module origin can be set to reflect its position.

Use the mouse cursor to point to the top of the segments (the top turns red); click and drag it in the desired position.
To apply the changes, click the apply button.

The module orientation is saved in the module and can also be modified by editing the parameters in the module position settings window (see section 5.4.3 Module Position).

5.4. Settings

The module stores several settings. Once saved in the module, these parameters are effective at each power up. The Leddar™ Configurator software loads these parameters upon each connection.

5.4.1. Device Name

When you connect to a module for the first time, it has a default name. You can change that name at any time.

To change the device name:

1. Connect to a device.
2. On the Device menu, point to Configuration and click Device Name.
3. In the **Device Name** dialog box, in the **Name** box, type the new name of the device and click **OK**.

![Device Name dialog box](image)

**Figure 34: Device Name dialog box**

To apply the change, click the apply button ![✓](image) in the Leddar™ Configurator main window.
5.4.2. Acquisition Settings

The acquisition settings allow you to define parameters to use for detection and distance measurement.

To open the **Acquisition Settings** dialog box, select **Device > Configuration > Acquisition**.

![Figure 35: Acquisition Settings dialog boxes](image)

To apply the changes, click the apply button in the main window.

Refer to section 3.3 Acquisition Settings for more details on all the parameters.
5.4.3. Module Position

The module position allows you to define the module position with respect to the reference of the system it is used in. See sections 5.3.8 and 5.3.9 for more information.

To open the Module Position dialog box, on the Device menu, point to Configuration and click Position.

![Figure 36: Device menu and Module Position dialog box](image)

The numbers are modified either by using the arrows or by entering the value manually.

The Reset to defaults button replaces the segments to their original manufacturing positions.

5.4.4. Advanced Detection Zones

An Advanced Detection Zone is a configurable setting allowing to display detections only if they are located in the specified zone.

To open the Advanced Detection Zones dialog box, on the Device menu, point to Configuration and click Advanced Detection Zones.

![Figure 37: Device menu, and the Configuration and Advanced Detection Zones menu items](image)
In the **Advanced Detection Zones** dialog box, configuration lines are entered to define the zone of interest.

![Advanced Detection Zones dialog box](image)

**Figure 38: Advanced Detection Zones dialog box**

5.4.5. General

The module **General** communication settings are configurable.

To open the **General Settings** dialog box, on the **Device** menu, point to **Configuration**, point to **Communication**, and click **General**.

![Device menu, and the Configuration and Communication menu items](image)

**Figure 39: Device menu, and the Configuration and Communication menu items**

In the **General Setting** dialog box, in the **Distance Units** list, select the units with which you want to work.
The number of channels used is set to 16 by default but you can remove some of them to suit your application through the LeddarHost dialog box. Next to Channel Select, click **Modify** and clear the desired check boxes.

In Modbus and CAN communications, you can either enable or disable one or more channels.
5.4.6. Serial Ports

The module serial port settings are configurable.

To open the Serial Ports Settings dialog box, on the Device menu, point to Configuration, point to Communication, and click Serial Ports.

![Figure 42: Device menu, and the Configuration and Communication menu items](image)

In the Serial Port Setting dialog box, the numbers are modified by using the arrows or by entering the value manually.

![Figure 43: Serial Ports Settings dialog box](image)

**NOTE:** The Detections parameter can be limited to 40 if used with a 0x6A Modbus function.

The following table describes the serial port settings.
Table 34: Serial port settings description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>Select 1 for the RS-485 port on the terminal block.</td>
</tr>
<tr>
<td></td>
<td>Select 2 for the expansion connector.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600 bps</td>
</tr>
<tr>
<td></td>
<td>19,200 bps</td>
</tr>
<tr>
<td></td>
<td>38,400 bps</td>
</tr>
<tr>
<td></td>
<td>57,600 bps</td>
</tr>
<tr>
<td></td>
<td>115,200 bps</td>
</tr>
<tr>
<td></td>
<td>230,400 bps</td>
</tr>
<tr>
<td></td>
<td>460,800 bps</td>
</tr>
<tr>
<td></td>
<td>921,600 bps</td>
</tr>
<tr>
<td>Parity</td>
<td>None, Odd, Even</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1, 2</td>
</tr>
<tr>
<td>Address</td>
<td>1 to 247</td>
</tr>
<tr>
<td>Detections²</td>
<td>0 to 48</td>
</tr>
</tbody>
</table>

¹ To avoid errors, it is recommended not to select these rates. Availability according to selected serial port.
² This parameter can be limited to 40 if used with a 0x6A Modbus function.

5.4.7. CAN Ports

The module CAN port settings are configurable.

To open the CAN Port Settings dialog box, on the Device menu, point to Configuration, point to Communication, and click CAN Ports.

Figure 44: Device menu, and the Configuration and Communication menu items
In the **CAN Port Setting** dialog box, the numbers are modified by using the arrows or by entering the value manually.

![CAN Port Settings dialog box](image)

**Figure 45: CAN Port Settings dialog box**

The following table describes the CAN port settings.

**Table 35: CAN port settings description**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Port Number</strong></td>
<td>Select 1 for CAN communication.</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td>10, 20, 50, 100, 125, 250, 500, 1000 kbps.</td>
</tr>
<tr>
<td><strong>Base Tx Id</strong></td>
<td>The CAN arbitration ID used for data messages coming from the evaluation kit containing the detections. The arbitration ID of the messages containing the number of detections will be this value plus one (see the protocol documentation).</td>
</tr>
<tr>
<td><strong>Base Rx Id</strong></td>
<td>The CAN arbitration ID used for data messages sent to the evaluation kit (see the protocol documentation).</td>
</tr>
<tr>
<td><strong>Frame Format</strong></td>
<td>Standard, Extended.</td>
</tr>
<tr>
<td><strong>Inter-Message Delay</strong></td>
<td>0 to 65535 milliseconds.</td>
</tr>
<tr>
<td><strong>Inter-Cycle Delay</strong></td>
<td>0 to 65535 milliseconds.</td>
</tr>
<tr>
<td><strong>Detection Flag Info</strong></td>
<td>The information on the detection flag is displayed in the main window.</td>
</tr>
<tr>
<td><strong>Detections</strong></td>
<td>1 to 96.</td>
</tr>
<tr>
<td><strong>Detection Transfer</strong></td>
<td>Single or multiple messages.</td>
</tr>
</tbody>
</table>
5.5. Saving and Loading a Configuration

The software configuration for a device can be saved to a file. This enables you to back up settings and restore them in case of system failure or in case you want to revert to earlier settings. You can also get the configuration that was stored with a record file.

To save a configuration:
On the File menu, click Save Configuration.

To load a configuration:
On the File menu, click Load Configuration.

5.6. Configuring Detection Records

Detection records provide a playback of detections recorded by a device. This visual information can be useful for verification, troubleshooting, or training purposes. Detection records allow for a full data playback stored in a *.ltl file that can later be reloaded and replayed.

To configure the detection record:
1. In Leddar™ Configurator, on the Settings menu, click Preferences.
2. In the **Preferences** dialog box, click **Recording** and click **Recorder**.

![Preferences dialog box](image)

**Figure 48: Preferences dialog box**

3. Under **Directory**, click the **Browse** button to select the path where you want to save the detection record file.

4. In the **Maximum file size** box, set the maximum file size by using the arrows or by entering the value manually.

5. Under **What**, select the **Log debug information** check boxes.

6. Under **How Long**, next to **Maximum record time**, determine the length of time for recording by using the arrows or by entering the value manually.

   At the end of that period, recording will stop even if the file size has not reached its maximum.

7. Click **OK** to save the settings.

A complete description of the elements found in the **Preferences** for recording dialog box follows the next two procedures.

**To start a recording:**

On the **File** menu, click **Start Recording**.
To stop a recording manually:

On the **File** menu, click **Stop Recording**.

The following is a description of the elements available in the **Preferences** for recording dialog box.

**Record directory**

The record directory is the folder in which all record files will be saved. These files are in a proprietary format, with the extension *.ltl, and can only be opened and viewed with the Leddar™ Configurator software.
Maximum file size

Record files can be quite large. Set the maximum file size as needed. The recording stops for the current file once it reaches the maximum file size and automatically switches the recording to another file. This is to keep record files of manageable sizes.

Debug

These check boxes are reserved for the use of LeddarTech® debug purposes.

Maximum record time

The value entered as the Maximum record time determines the length of the time for recording. At the end of that period, recording will stop even if the file size has not reached its maximum.

5.7. Using Detection Records

Once you have completed a recording, you can review it and extract part of the recording.

The Record Replay dialog box offers the same functions as a regular video player: there is a stop button, a play button, and frame-by-frame forward and backward buttons.

The Position slider lets you move directly to a desired position.

The Playback Speed slider lets you adjust the speed of the recording playback; faster is to the left.

The Start, End, and Extract buttons allow you to select a portion of the recording and extract it for further reference or analysis.

To play a record:

If you are connected to a device, disconnect from the device.

Another option is to open another Leddar™ Configurator main window.

NOTE: The record files can also be opened by double-clicking them.
8. On the File menu, click Replay.

![File menu to open a recording](Figure 51)

9. In the Record Replay dialog box, click the Browse button to select a file.

![Record Replay dialog box](Figure 52)

10. Click the play button to start the playback.

To extract a record file segment:

1. Set the Position slider to the position where you want the file segment to start and click the Start button.

2. Set the Position slider to the position where you want the file segment to stop and click the End button.

   OR

   Play the record and stop it at a position of interest and then click the Start button; restart playing the record and stop it again at a position of interest and click the Stop button.

3. Click the Extract button to extract and save that file segment.
5.8. Data Logging

The data logging function is used to output the data to a .txt file. This file can be imported in a software application, such as Microsoft Excel, for offline analysis.

The duration of the record is indicated in the status bar.

Each line of the generated text file contains the information related to a single detection.

Table 36: Field description of the log text file

<table>
<thead>
<tr>
<th>Time (msec)</th>
<th>Segment [0 15]</th>
<th>Amplitude [0 512]</th>
<th>Distance (m)</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>12735204</td>
<td>7</td>
<td>0.9</td>
<td>33.61</td>
<td>1</td>
</tr>
</tbody>
</table>

In this table,

- **Time** indicates the timestamp of the detection from when the module was connected to the power supply.
- **Segment** refers to the location of the detection (line, column).
- **Amplitude** of the detection indicates the strength of the returned signal.
- **Distance** indicates the distance of the detection in meters or in feet depending on the distance unit configured in the Preferences menu.
- **Status** corresponds to a flag value. Refer to Section 5.11 Raw Detections for more details.

To use the data logging function:
1. In Leddar™ Configurator, on the Settings menu, click Preferences.

![Figure 53: Settings menu](image)

2. In the Preferences dialog box, click Recording and click Data Logger.
Figure 54: Preferences dialog box for logging data

3. Under **Directory**, click the **Browse** button to select the path where you want to save the log and click **OK**.

4. On the **File** menu, click **Start Data Logging**.

Figure 55: File menu

5. To stop recording, on the **File** menu, click **Stop Data Logging**.

Figure 56: File menu to stop data recording

A .txt file is saved in the selected directory.
5.9. Device State

Information about a device is accessible when connecting to a device in the Connection window or by clicking the State command on the View menu.

![Figure 57: View menu](image)

The Device State window opens.

![Figure 58: Device State window](image)

**Temperature**

This section indicates the temperature of the device.

**Timers & Load**

This feature gives information in days, hours, minutes, and seconds about the time elapsed since the last module reset.

The CPU Load indicates how much of the module processor capacity is in use. When the load reaches near 100%, the processor may no longer be able to process all the data. The effective frame rate may be impacted.
The Measurement Rate indicates the rate at which the module measures the speed and dimension of static or moving surfaces.

Device Information

The Serial Number is the number of the device as assigned by LeddarTech.

The Version includes the following:
- FPGA: The firmware version of the device.
- Software: The software version of the device.
- CRC: Indicates the firmware version to ensure that it is authentic.

The Part Numbers provide the hardware and software part numbers of a device as assigned by LeddarTech.

The LED Intensity (laser intensity) is the current laser power in use by the module. It automatically adapts to too strong/too weak detections when properly activated in the acquisition settings window.

The Demerging indicates the current object demerging status, when activated in the acquisition settings. It may be:
- Partial: When the demerge module did not process all pulses characteristic of merged objects.
- Completed: When the module processed all pulses characteristic of merged objects.

5.10. Preferences

Preferences are used to change various settings related to the display of Leddar™ Configurator.

The Preferences dialog box is opened by clicking the Preferences command on the Settings menu.
Windows

The two options allow the user to select how the content of the main window will be displayed in Leddar™ Configurator. Choices are:

- The **Restore window position and size on startup** feature starts Leddar™ Configurator at the same place on the computer desktop and at the same size it was when it was closed.
- The **Restore window layout on connection** feature connects to the Evaluation Kit at the same size it was and with all docked dialog boxes or windows that were displayed when it was closed.

Units

The unit that is applied to distances displayed in Leddar™ Configurator.

The temperature is the unit used when displaying temperatures.

Recording

The **Recorder** parameter lets you choose how data files are recorded.

The **Data Logger** parameter lets you select a directory to store logs.

Display

The **Detection Arc Thickness** parameter allows a user to modify the pixel width of the displayed green detections arcs in the main window.

5.11. Raw Detections

The **Raw Detections** dialog box allows you to view detection values in many ways. It provides filters to isolate segments and detection parameters.

To open the **Raw Detections** dialog box, on the **View** menu, click **Raw Detections**.
Figure 60: View menu and Raw Detections dialog box

Figure 61 presents an example of raw detections. When there is no detection in some segments, only the segments where detection occurred appear in the list.

Figure 61: Example of detection filtering in the Raw Detection dialog box.
The following is a description of the parameters in the **Raw Detections** dialog box.

**Min and Max Amplitude**

The value entered in the **Min Amplitude** box shows only detections of amplitude higher or equal to that value in meters. For example, if the minimum amplitude is set to 5, only the detections of amplitude 5 and more will be displayed.

The value entered in the **Max Amplitude** box will show only detections of amplitude lower or equal to that value in meters. For example, if the maximum amplitude is set to 8, only the detections of amplitude 8 and lower will be displayed.

Setting a value in both fields will result in a range of amplitude to display.

**Min and Max Distance**

The value entered in the **Min Distance** box will show only detections at a distance greater or equal to that value. For example, if the minimum distance is set to 10, only the detections at a distance of 10 and more will be displayed.

The value entered in the **Max Amplitude** box will show only detections at a distance smaller or equal to that value. For example, if the minimum distance is set to 20, only the detections at 20 and less will be displayed.

Setting a value in both fields will result in a range of distance to display.

**Boxes 1 to 16**

Check boxes 1 to 16 allow you to select which segments to display.

**Freeze**

When selected, the **Freeze** parameter freezes the values displayed in the **Raw Detections** dialog box. To return to the live display, clear the check box.

**Seg**

The **Seg** column lists the segment for which there is a detection according to the filters used. The segment numbers are read from left to right starting at 1.

**Distance and Amplitude**

The **Distance** column displays the distance of the detection and the **Amplitude** column displays its amplitude.

**Flag**

The **Flag** column displays a number that represents a detection type. See Table 37.
Table 37: Flag value description

<table>
<thead>
<tr>
<th>Bit position</th>
<th>Bit 0</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Invalid measurement.</td>
<td>Valid measurement.</td>
</tr>
<tr>
<td>1</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
<tr>
<td>2</td>
<td>Normal measurement</td>
<td>Interference was detected in the current frame</td>
</tr>
<tr>
<td>3</td>
<td>Normal measurement</td>
<td>Received signal is above the saturation level. Measurements are valid (VALID is set) but have a lower accuracy and precision. Consider decreasing the laser intensity.</td>
</tr>
<tr>
<td>4</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
<tr>
<td>5</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
<tr>
<td>6</td>
<td>Normal measurement</td>
<td>Detection is within the crosstalk zone</td>
</tr>
<tr>
<td>7</td>
<td>Reserved.</td>
<td>Reserved.</td>
</tr>
</tbody>
</table>
The **Flag** field provisions for 8 bits encoded as a bit field. Three bits are currently used. The following table presents the implemented decimal values of the status bit field.

**Table 38: Status value description**

<table>
<thead>
<tr>
<th>Status value (decimal)</th>
<th>Status value (binary)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>00000001</td>
<td>Normal measurement (valid).</td>
</tr>
<tr>
<td>9</td>
<td>00001001</td>
<td>Saturated signal (valid).</td>
</tr>
</tbody>
</table>

### 5.12. View Serial Part Data

When using a device through a serial port (for example, using an RS-485 to USB adapter cable), it is possible to establish a connection to the module and display the module measurements in Leddar™ Configurator.

**To view the serial port data:**

1. On the **View** menu, click **Serial Port Viewer**.

![Figure 62: View menu](image)

2. In the **Serial Port Viewer** dialog box, in the **Port** list, select the serial port of the connected module.
3. Click the **Start** button to establish connection and display the measurements.
6. Specifications

This chapter presents the M16 LSR specifications.

6.1. General

Table 39: General specifications

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>M16R-75J0012 (19° x 0.3°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0003 (19° x 3°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0002 (36° x 0.2°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0007 (48° x 0.3°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0008 (48° x 3°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0001-2 (48° x 5.1°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0011-1 (48° x 5.5°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0009 (99° x 0.3°)</td>
</tr>
<tr>
<td></td>
<td>M16R-75J0010 (99° x 3°)</td>
</tr>
<tr>
<td>Dimensions Depth x Height x Length (mm)</td>
<td>71 x 64 x 76</td>
</tr>
<tr>
<td></td>
<td>74 x 64 x 66</td>
</tr>
<tr>
<td></td>
<td>62 x 64 x 66</td>
</tr>
<tr>
<td></td>
<td>62 x 64 x 66</td>
</tr>
<tr>
<td>Weight (g)</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>182</td>
</tr>
<tr>
<td>Interface</td>
<td>USB, RS-485, CAN, UART</td>
</tr>
<tr>
<td>Power Supply</td>
<td>12 V to 30 V</td>
</tr>
<tr>
<td>Power consumption</td>
<td>&gt; 4 W</td>
</tr>
</tbody>
</table>
6.2. Environmental

Table 40: Environmental specifications

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>−40 °C to +85 °C</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>−40 °C to +85 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>5% to 95%</td>
</tr>
<tr>
<td>Vibration resistance, unpacked</td>
<td>Sinusoidal vibrations basic unit 5 with 200 Hz, constant amplitude 0.3 cm, 1 G</td>
</tr>
<tr>
<td>Mechanical shocks, unpacked</td>
<td>½ sine 30 G, 11 ms 3 shocks per direction and axis</td>
</tr>
</tbody>
</table>

6.3. Regulatory Compliance

The M16 LSR complies with the following standards:

- FCC Class B
- RoHS
- CE (EMC Class B or EN 60950)
# 6.4. Optical

Table 41: Optical specifications

<table>
<thead>
<tr>
<th>Model</th>
<th>Beam width, horizontal FOV</th>
<th>Beam height, vertical FOV</th>
<th>Laser pulse rate (Hz)</th>
<th>Photodetector array size</th>
<th>Wavelength</th>
<th>Laser risk group</th>
</tr>
</thead>
<tbody>
<tr>
<td>M16R-75J0001-2</td>
<td>48°</td>
<td>5.1°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0002</td>
<td>36°</td>
<td>0.2°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0003</td>
<td>19°</td>
<td>3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0007</td>
<td>48°</td>
<td>0.3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0008</td>
<td>48°</td>
<td>3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0009</td>
<td>99°</td>
<td>0.3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0010</td>
<td>99°</td>
<td>3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0011-1</td>
<td>48°</td>
<td>5.5°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0012</td>
<td>19°</td>
<td>0.3°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Figure 65: Horizontal field of view (HFOV) and Vertical field of view (VFOV)
### 6.5. Performance

Table 42: Module performances

<table>
<thead>
<tr>
<th>Model</th>
<th>Maximum range with retro-reflector (m)(^1), (^4)</th>
<th>Maximum range with white target (m)(^2), (^4)</th>
<th>Maximum range with gray target (m)(^3), (^4)</th>
<th>Measurement accuracy (cm)</th>
<th>Measurement precision (mm)</th>
<th>Measurement rate (Hz)</th>
<th>Measurement resolution (cm)</th>
<th>Range (maximum laser intensity value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M16R-75J0001-2 (48° x 5.1°)</td>
<td>60</td>
<td>16</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0002 (36° x 0.2°)</td>
<td>146</td>
<td>37</td>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0003 (19° x 3°)</td>
<td>110</td>
<td>31</td>
<td>18</td>
<td>±5</td>
<td>±6</td>
<td>Up to 100(^5)</td>
<td>±1</td>
<td>Varies with beam optics and target properties (see amplitude vs range figures below)</td>
</tr>
<tr>
<td>M16R-75J0007 (48° x 0.3°)</td>
<td>118</td>
<td>31</td>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0008 (48° x 3°)</td>
<td>85</td>
<td>19</td>
<td>13</td>
<td>±5</td>
<td>±6</td>
<td>Up to 100(^5)</td>
<td>±1</td>
<td></td>
</tr>
<tr>
<td>M16R-75J0009 (99° x 0.3°)</td>
<td>61</td>
<td>12</td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0010 (99° x 3°)</td>
<td>34</td>
<td>9</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0011-1 (48° x 5.5°)</td>
<td>91</td>
<td>23</td>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M16R-75J0012 (19° x 0.3°)</td>
<td>165</td>
<td>41</td>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Retro-reflector reference target corresponds to a 5 cm x 7 cm band of retro-reflective tape.
2. White reference target corresponds to a 20 cm x 25 cm Kodak Greycard with 90% reflectivity.
3. Gray reference target corresponds to a 20 cm x 25 cm Kodak Greycard with 18% reflectivity.
4. Ranges are evaluated at 32 accumulations and 8 oversamplings.
5. See Table 13 for typical measurement rate calculation.
6.6. Dimensions

This section presents the M16 LSR dimensions.

6.6.1. 36° x 0.2° Module (M16R-75J0002)

Figure 66: Module 36° x 0.2° dimensions
6.6.2. 19° x 0.3° Module (M16R-75J0012)

Figure 67: Module 19° x 0.3° dimensions
6.6.3. 19° x 3° Module (M16R-75J0003)

Figure 68: Module 19° x 3° dimensions
6.6.4. 48° x 0.3° Module (M16R-75J0007)

![Diagram of the 48° x 0.3° Module]

**Figure 69: Module 48° x 0.3° dimensions**
6.6.5. 48° x 3° Module (M16R-75J0008)

Figure 70: Module 48° x 3° dimensions
6.6.6. 48° x 5.1° Module (M16R-75J0001)

Figure 71: Module 48° x 5.1° dimensions
6.6.7. 48° x 5.5° Module (M16R-75J0011-1)

Figure 72: Module 48° x 5.5° dimensions
6.6.8. 99° x 0.3° Module (M16R-75J0009)

Figure 73: Module 99° x 0.3° dimensions
6.6.9. 99° x 3° Module (M16R-75J0010)

![Module 99° x 3° dimensions](image)

**Figure 74: Module 99° x 3° dimensions**
7. Technical Support

For technical inquiries, please contact LeddarTech technical support at support@leddartech.com to easily:

- Follow up on your requests
- Find quick answers to questions
- Get valuable updates

Or by contacting us at:

- + 1 418 653 9000
- + 1 855 865 9900

8:30 a.m. - 5:00 p.m. Eastern Standard Time

To facilitate the support, please have in hand all relevant information such as part numbers, serial numbers.

E-mail

support@leddartech.com

Company address

LeddarTech Inc.
4535, boul. Wilfrid-Hamel, #240
Quebec, QC  G1P 2J7
Canada

www.leddartech.com
Appendix A.  Example of a 0x41 Modbus Function

Transmit data stream message

01 41 C0 10

Use the 0x41 command to read the Modbus address # 01, using the CRC C0 10.

Received data stream message

01 41 10 CA 01 58 04 01 DA 01 2F 04 11 C0 01 94 04 21 D0 01 2F 04 31 B6 01
BF 04 41 C6 01 76 04 51 B3 01 D5 04 61 C7 01 7E 04 71 AE 01 EB 04 81 C2
01 93 04 91 AD 01 F5 04 A1 C6 01 55 04 B1 B2 01 F1 04 C1 CC 01 48 04 D1
B0 01 DA 04 E1 D3 01 2D 04 F1 CF 61 02 00 64 03 0F DB

Get detection messages (first byte)

Modbus address: 01 hex = 1 = address#1
Function code: 41 hex = 65 = function 0x41
Number of detections: 10 hex = 16 = 16 detections

Get detection messages (detection fields), refer to Table 17 on page 44.

(1) CA 01 58 04 01:
Distance (cm): 01 CA hex = 458 cm
Amplitude (count): 04 58 hex = 1112 / 64 = 17.375 counts
Segment/Flags #: 01 hex (segment #0, flag = valid)

(2) DA 01 2F 04 11:
Distance (cm): 01 DA hex = 474 cm
Amplitude (count): 04 2F hex = 1071 / 64 = 16.734 counts
Segment/Flags #: 11 hex (segment #1, flag = valid)

(3) C0 01 94 04 21:
Distance (cm): 01 C0 hex = 448 cm
Amplitude (count): 04 94 hex = 1172 / 64 = 18.313 counts
Segment/Flags #: 21 hex (segment #2, flag = valid)

(4) D0 01 2F 04 31:
Distance (cm): 01 D0 hex = 464 cm
Amplitude (count): 04 2F hex = 1071 / 64 = 16.734 counts
Segment/Flags #: 31 hex (segment #3, flag = valid)

(5) B6 01 BF 04 41:
Distance (cm): 01 B6 hex = 438 cm
Amplitude (count): 04 BF hex = 1215 / 64 = 18.984 counts
Segment/Flags #: 41 hex (segment #4, flag = valid)
(6) C6 01 76 04 51:

Distance (cm): 01 C6 hex = 454 cm
Amplitude (count): 04 76 hex = 1142 / 64 = 17.844 counts
Segment/Flags #: 51 hex (segment #5, flag = valid)
(7) B3 01 D5 04 61:

Distance (cm): 01 B3 hex = 435 cm
Amplitude (count): 04 D5 hex = 1117 / 64 = 17.453 counts
Segment/Flags #: 61 hex (segment #6, flag = valid)
(8) C7 01 7E 04 71:

Distance (cm): 01 C7 hex = 455 cm
Amplitude (count): 04 7E hex = 1150 / 64 = 17.969 counts
Segment/Flags #: 71 hex (segment #7, flag = valid)
(9) AE 01 EB 04 81:

Distance (cm): 01 AE hex = 430 cm
Amplitude (count): 04 EB hex = 1259 / 64 = 19.671 counts
Segment/Flags #: 81 hex (segment #8, flag = valid)
(10) C2 01 93 04 91:

Distance (cm): 01 C2 hex = 450 cm
Amplitude (count): 04 93 hex = 1171 / 64 = 18.267 counts
Segment/Flags #: 91 hex (segment #9, flag = valid)
(11) AD 01 F5 04 A1:

Distance (cm): 01 AD hex = 429 cm
Amplitude (count): 04 F5 hex = 1119 / 64 = 17.484 counts
Segment/Flags #: A1 hex (segment #10, flag = valid)
(12) C6 01 55 04 B1:

Distance (cm): 01 C6 hex = 454 cm
Amplitude (count): 04 55 hex = 1109 / 64 = 17.328 counts
Segment/Flags #: B1 hex (segment #11, flag = valid)
(13) B2 01 F1 04 C1:
Distance (cm): 01 B2 hex = 434 cm
Amplitude (count): 04 F1 hex = 1115 / 64 = 17.422 counts
Segment/Flags #: C1 hex (segment #12, flag = valid)

(14) CC 01 48 04 D1:

Distance (cm): 01 CC hex = 460 cm
Amplitude (count): 04 48 hex = 1096 / 64 = 17.125 counts
Segment/Flags #: D1 hex (segment #13, flag = valid)

(15) B0 01 DA 04 E1:

Distance (cm): 01 B0 hex = 432 cm
Amplitude (count): 04 DA hex = 1242 / 64 = 19.406 counts
Segment/Flags #: E1 hex (segment #14, flag = valid)

(16) D3 01 2D 04 F1:

Distance (cm): 01 D3 hex = 467 cm
Amplitude (count): 04 2D hex = 1069 / 64 = 16.703 counts
Segment/Flags #: F1 hex (segment #15, flag = valid)

Get detection messages (trailing fields), refer to Table 18 on page 45.

CF 61 02 00 64 03 0F DB:
TimeStamp (ms): 00 02 61 CF hex = 156111 ms = 156 s
Light source POWER (%): 64 hex = 100 = 100%
Bit field acq. (reserved): 00 hex = 0
CRC (16-bits Modbus) = 0F DB
Appendix B. Example of a 0x04 Modbus

Transmit message

\[ \text{01 04 00 00 00 30 F0 1E} \]

Use the 0x04 command to read 48 consecutive registers starting at address 00. On device with Modbus address 01, using the CRC F0 E1.

Received message

\[ \text{01 04 60 2D 00 00 01 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 01 64 89 9B 00 2B 01 CB 01 DF 01 C3 01 D4 01 BB 01 CC 01 B5 01 CA 01 B0 01 C5 01 AE 01 CA 01 B4 01 D2 01 B3 01 D9 04 00 03 FB 04 30 03 D0 04 4D 04 08 04 6C 04 09 04 77 04 21 04 84 03 E8 04 85 03 D8 04 6E 03 DD FA 29} \]

Header

(Address 0) Module temperature: 2D 00 hex = 11520/256 = 45.0°C
(1) Status for polling mode: 00 01 hex = 1 = Detections ready
(13) Light source power & Acquisition statuses: 01 64 hex, acquisition status = 01 hex = automatic light power, light source power = 64 hex = 100 = 100%
(14&15) TimeStamp: 00 2B 89 9B hex = 2853275 = 2853275 ms (2853 s)

Modbus footer

Modbus CRC-16: FA 29 hex

Distance (first detection only)

(Address 16) Segment #0 = 01 CB hex = 459 cm
(17) Segment #1 = 01 DF hex = 479 cm
(18) Segment #2 = 01 C3 hex = 451 cm
(19) Segment #3 = 01 D4 hex = 468 cm
(20) Segment #4 = 01 BB hex = 443 cm
(21) Segment #5 = 01 CC hex = 460 cm
(22) Segment #6 = 01 B5 hex = 437 cm
(23) Segment #7 = 01 CA hex = 458 cm
(24) Segment #8 = 01 B0 hex = 432 cm
(25) Segment #9 = 01 C5 hex = 453 cm
(26) Segment #10 = 01 AE hex = 430 cm
(27) Segment #11 = 01 CA hex = 458 cm
(28) Segment #12 = 01 B4 hex = 436 cm
(29) Segment #13 = 01 D2 hex = 466 cm
(30) Segment #14 = 01 B3 hex = 434 cm
(31) Segment #15 = 01 D9 hex = 473 cm

Amplitude (first detection only)
(Address 32) Segment #0 = 04 00 hex = 1024 / 64 = 16 counts
(33) Segment #1 = 03 EB hex = 1003 / 64 = 15.672 counts
(34) Segment #2 = 04 30 hex = 1072 / 64 = 16.75 counts
(35) Segment #3 = 03 D0 hex = 976 / 64 = 15.25 counts
(36) Segment #4 = 04 4D hex = 1101 / 64 = 17.203 counts
(37) Segment #5 = 04 08 hex = 1032 / 64 = 16.125 counts
(38) Segment #6 = 04 6C hex = 1132 / 64 = 17.688 counts
(39) Segment #7 = 04 09 hex = 1033 / 64 = 16.140 counts
(40) Segment #8 = 04 77 hex = 1143 / 64 = 17.859 counts
(41) Segment #9 = 04 21 hex = 1057 / 64 = 16.516 counts
(42) Segment #10 = 04 84 hex = 1156 / 64 = 18.063 counts
(43) Segment #11 = 03 E8 hex = 1000 / 64 = 15.625 counts
(44) Segment #12 = 04 85 hex = 1157 / 64 = 18.078 counts
(45) Segment #13 = 03 D8 hex = 984 / 64 = 15.375 counts
(46) Segment #14 = 04 6E hex = 1134 / 64 = 17.719 counts
(47) Segment #15 = 03 DD hex = 989 / 64 = 15.453 counts
Appendix C. Example of a CAN Bus Detection Request

The controller sends the following:

<table>
<thead>
<tr>
<th>ID</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0740</td>
<td>01</td>
</tr>
</tbody>
</table>

This message sends a request to receive the module detections only once.

The Leddar™ module answers the following:

<table>
<thead>
<tr>
<th>ID</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0751</td>
<td>0F</td>
</tr>
<tr>
<td>0750</td>
<td>BD 00 85 00 C8 00 CA 10</td>
</tr>
<tr>
<td>0750</td>
<td>CE 00 AD 21 CB 00 3A 32</td>
</tr>
<tr>
<td>0750</td>
<td>C8 00 A1 42 C6 00 ED 52</td>
</tr>
<tr>
<td>0750</td>
<td>C4 00 FB 62 C5 00 2C 73</td>
</tr>
<tr>
<td>0750</td>
<td>C6 00 3A 85 C7 00 EC 92</td>
</tr>
<tr>
<td>0750</td>
<td>C6 00 7D A2 C9 00 0D B2</td>
</tr>
<tr>
<td>0750</td>
<td>CD 00 72 C1 CE 00 3F D1</td>
</tr>
<tr>
<td>0750</td>
<td>D1 00 5F E1 00 00 00</td>
</tr>
</tbody>
</table>

The following explains the first three lines of the answer:

**ID: 0751**  **Data: 0F**

0751 indicates that the data in this message will be the number of sent detections.

The number of sent detections is 0F hex = 15 detections; therefore, there are seven 0750 messages each containing two detections and one 0750 message containing only one detection.

**ID: 0750**  **Data: BD 00 85 00 C8 00 CA 10**

0750 = 8-byte message containing two detections.

Detection 1:
Distance is 00 BD hex = 189 cm
Amplitude is 085 hex/4 = 133/4 = 33.25
Channel is 0
Detection 2:
Distance is 00 C8 hex = 200 cm
Amplitude is 0 CA hex / 4 = 202/4 = 50.25
Channel is 1
ID: 0750 Data: CE 00 AD 21 CB 00 3A 92
0750 = 8-byte message containing two detections.
Detection 1:
Distance is 00 CE hex = 206 cm
Amplitude is 1 AD hex / 4 = 429/4 = 107.25
Channel is 2
Detection 2:
Distance is 00 CB hex = 203 cm
Amplitude is 2 3A hex / 4 = 570/4 = 142.5
Channel is 3
Index

A
Accumulations........................................14, 30
Amplitude, raw detection...............................85

C
CAN bus..................................................16, 17
CAN port
  Baud rate ............................................41
  flag information ....................................41
  frame format ........................................41
  inter-cycle delay ....................................41
  inter-message delay ................................41
  maximum number of detection ....................41
  message mode .......................................41
  Rx ID ..................................................41
  Tx ID ..................................................41
Connection type ........................................60
Connector, power ......................................14
Contents ................................................11
CPU load ...............................................81
Crosstalk removal ......................................31
Custom features .......................................11

D
DAC ........................................................17
Data acquisition .......................................14
Data recording .........................................74
Delivery contents .....................................11
Demerging ...............................................82
Detection
  Filters, raw detection ................................83
  Using records .......................................74, 77
Detection arc
  Thickness .............................................83
Detection records, see also Records
Device
  Information ..........................................82
  Name ..................................................60
  Power outage .......................................81
  Serial number ......................................60, 82
  Temperature ........................................81
  Type ..................................................60
  Versions .............................................82
Dimensions ............................................89, 94
DIP switches ...........................................16
Distance unit ..........................................83
Distance, raw detection ..............................85

E
Expansion connector ..................................16

F
Features
  Custom ................................................11
  Standard .............................................11
File size, records ....................................75
Flag, raw detection ....................................85
FOV
  Vertical .............................................91
Freeze, raw detection ................................85

G
GPIO .....................................................17

H
Humidity ................................................90

I
Intensity, LED .........................................33

L
Laser
  Pulsing ...............................................14
  Pulsing controller ..................................15
LED
  Control ...............................................31
  Intensity ............................................31
  Status ...............................................17
LED Intensity .........................................82
Load, CPU .............................................81

M
Main window ...........................................25
Maximum file size, records ........................................ 77
MCU .......................................................... 15
MCU JTAG .................................................... 14
Measurement rate .............................................. 14, 82
MicroSD card slot ............................................. 14
MODBUS protocol ............................................ 43
module reset .................................................... 81

Name of device .................................................. 60

Object demerging .............................................. 31
Operating temperature ....................................... 89, 90
Oversampling .................................................. 14, 30

Part number .................................................. 82
Photodetector ................................................ 14
Point count .................................................... 30
Power connector ............................................ 14
Precision ....................................................... 91, 93
Preferences
  Display, window ........................................... 83
  Distance unit ............................................. 83
  Temperature unit ........................................ 83
Preferences, modifying ..................................... 82
Protocol, MODBUS ......................................... 43

Range .......................................................... 91, 93
Raw detection
  Amplitude ................................................ 85
  Distance .................................................. 85
  Flag ....................................................... 85
  Freeze .................................................... 85
  Segment ................................................ 85
Receiver ....................................................... 15
Receiver assembly .......................................... 14
Recording .................................................... 83
Recording detections ....................................... 74, 77
Recording, data ............................................. 74
Records
  Detection (video) ....................................... 74
  Directory ............................................... 76
  File size ............................................... 77
  Playing ................................................. 77
Record time length .......................................... 77
Recording .................................................. 74, 77
Starting and stopping ..................................... 75
Viewing ..................................................... 77
Reset ........................................................ 14
Resolution .................................................. 91, 93
RS-485 port .................................................. 16, 43

Segment, raw detection ..................................... 85
Serial number ............................................... 60, 82
Serial port
  Baud rate ................................................ 39
  Start/stop bit ......................................... 39
Settings
  Accumulations ........................................... 30
  LED Intensity .......................................... 31
  Object demerging ....................................... 31
  Oversampling ......................................... 30
  Point count ............................................ 30
  Smoothing ............................................. 30
  Threshold offset ....................................... 30
Smoothing .................................................. 30, 34
Source and control assembly ............................. 15
SPI ......................................................... 17
Standard features .......................................... 11
Status LEDs ............................................... 17
Storage temperature ....................................... 89, 90

Temperature
  Operating ................................................. 89, 90
  Storage .................................................. 89, 90
Temperature of a device .................................. 81
Temperature unit .......................................... 83
Terminal block ........................................... 12
Threshold offset ......................................... 30
Timers & Load ............................................ 81
Type, device ............................................... 60

UART ........................................................ 17
Units
  Distance ................................................ 83
  Temperature ........................................... 83
USB port ................................................... 14, 89
<table>
<thead>
<tr>
<th>V</th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Versions, device...........................82</td>
<td>Wavelength..................................91</td>
</tr>
<tr>
<td>Weight......................................89</td>
<td>Window ......................................83</td>
</tr>
</tbody>
</table>
| Window .................}